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How does the SMART Board
Interactive whiteboard work?

The SMART Board™" interactive whiteboard is very casy to use. If you can use a computer, you can yse an
interactive whitehoard,

The fouch-sensilive display connects to your computer and projector to show your camputer image. You
can conlrol applications from the display with vour finger. write notes in digital ink and save your work fo
share fater.



Getting started

How does the SMART Board interactive whiteboard work?

The SMART Board interactive whiteboard is touch sensitive and operates as part of 3 system that includes
a computer and a projector.

+ The computer sends an image of an application to the projectar
+ The projector casts the image onlo the interactive whiteboard

* The interactive whiteboard acts as both the monitor and input device. allowing you to control an
application by simply touching the interactive whiteboard

It may help you to think of your interactive whiteboard the same way you think of your mouse or keyboard
—itis an input device that enables you to control applications on your compute:
Safety tips

You and your students should never look direclly al the light beam from the projector. You (and your
students) should always take a slep (or even two) sideways before turning to face the class.

+ Tell your students not to touch the projector, as it can become extremely hot during normal operation

* Lont use a chair to increase a student's reach If your students can't reach the top of the interactive
whiteboard, lower il You may need to remount a wall-mounted unit to a lower position. If your interactive
whiteboard iz mounted on a floor stand, lower it with the help of anather adull,

= Tell students not ta run in the vicinity of the floor stand, as they may trip over the floor stand's feet
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Your finger is your mouse

You can control applications on your computer from the interactive whiteboard, A
press with your finger on a SMART Board interactive whiteboard is the same as a olick
with your mouse. You open an application the same way you do on your desktop
computer, but instead of using your mouse fo selecl and open files, just press or
double-press the application icon with your finger.

Crienting the interactive whiteboard will ensure the cursor is aligned with your finger
press. Crienting is discussed in detail on page six.

The SMART Pen Tray

The SMART Pen Tray consists of four color-coded slots for pen tocls and one slot for the eraser, Each siot
has an oplical sensor to identify when the pen tools and eraser have been picked up. You can write with the
pen lool orwith your finger, as long as a pen slot is empty. The technology in the pen tray is smarl enough
ta know which tool was remaoved from ils slol most recently. If you remove the eraser from its slot while YLl
are still holding a pen Loal, the pen tray will assume you want to erase. The lights above the tool slots
indicate which tool was removed last,

The pen-tray buttons

The pen tray has at least two pen-tray buttons. One butten is used to launch the On-Sereen Keyboard The
second button is used to make your next touch on the interactive whiteboard a right-click. Some interactive
whiteboards have a third bullon. The third bution is used to access the Help Center quickly.

Pan-fray huttons Pen-tray buffons

The pen tools

The SMART Board interactive whiteboard comes with four pen tools, which are black, red, green and blue,
and one eraser. Although you do nol need to use the pen tools to write on your interactive whiteboard, they
do make writing more intuitive Pick up a pen tool from the SMART Pan Tray and begin writing. Te crasc
your digilal ink, remove the eraser from the pen tray and move it in a smooth motion over your noles. The
notes will disappear.
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The On-Screen Keyboard

This on-screen, virtual keyboard eliminates the need for an attached physical keyboard, as you can use its
many views (o enler lyped text. There are several available keyboard views, including the Classic, Writs,
Simple, Simple Capitals, Number Pad and Shortcut view

To open the keyboard, press the SMART Board icon in the notification area and select Keyboard.
Alternatively, press the Keyboard button on your SMART Board interactive whiteboard pen tray,

Type or edit text in any applicalion without leaving the interactive whiteboard.
Fress the Keyboard button on the pen tray to launch the On-Screen Keyboard.

Classic view

Press the virtual keys to type text, than press lhe Send button to place the text into the active dialog box or
application. You can type inle any application, whether it's Ink Aware or not.
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Double-arrow button

Press the double-arrow button to open the Preview Pane. When the Preview Pane is open, you can type
an entire word or sentence before sending any information to an application. When you are finished typing,
pressing the Send button will send your lext to the active application,

Dowibie Arraw botion
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Simple view

Teachers wha are leaching students who are just learning the alphabet, or who are not yet familiar with a
standard keyboard layout, will appreciate the two simple views available Simple and Simple Caps. In both
of these views, the letters are arranged in alphabelical order, followed by digits 0 through 9.
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The right mouse button

Press the right mouse bullon on the pen tray to have your next press on the
soreen recognized as a right-click,

A graphic in the bottom right of your screen will appear to remind you that your
next press will be registered as a nght-click,

Tie: Instead of pressmg the right mouse button, press and hold on the area ﬂf the screen whers vouwould:
like to make a right-click. After a few seconds of pressmg and hnldlng the area, the right-click menu will
appear.
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Orienting your SMART Board interactive whiteboard

Orientation ensures your touch is registerad

accurately when you are using the interactive o, 0 o
whiteboard. Bt -
If you are touching an icon and your cursor appears Prwes vyrilii-of lrgat and raloase;

somewhere other than where you are pressing, try

arienting the interactive whiteboard, After orientation,
your cursor should appear wherever you are touching o < 0
the interactive whileboard.

To launch the Orient function, press and hold the
keyboard button and the right mouse button

simultaneously until the Crientation screen appears, o o .

The Cricalabion sereern

The Help button

Itthe pen tray features a help button, press it to launch the Help and Support for
Your SMART Board Inferactive Whiteboard dialog box, The dialog box provides
ane-touch access to information that will help you answer almost any question

relating to your SMART product.
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The Ready Light

Motebook softwane training for SMART Board users fovel 1 learmer workbook

Your SMART Board interactive whiteboard includes a Ready Light that indicates the status of your

interactive whiteboard.

I
e e——l

Color of Ready Light

Etatus

Mo it

The interactive whitebeard dees nol have power

* “heck the USE cable connections

Solid green

The interactive whiteboard is successfully communicating with the
SMART Board software on the computer

Flashing green

» The SMART Board driver isn't installed, Crifits inatalled,.it isn'L running.
Verify that the driver is installed, and if it isn't, install it

- Ifthe Ready Light continues to flash green, you may want to cantact your
supporl representative for assistance

Solid red

= The interactive whiteboard has power, but it is not cormmunicating with the
computer

= During the initial powering up or power reset, you will see the Ready Light
tum red for a moment

+ This brief red illumination is normal

Flashing amber

Solid amber

Writing notes

+ Ocours only when you are updating firmware using SMART's Firmware
Flashing Wizard

- This is normal

= Problem state

+ Try resetting the interactive whiteboard by disconnecting and then
reconnecting the USE cable al the interactive whiteboard end

Make notes or drawings by removing a pen toc! fram the pen tray and writing on the surface of the

interactive whiteboard.

The Digital Ink Layer

Whean you remove a pen tool from the pen tray, a border appears around your de&.ktup and the Floating
Tools toolbar launches. If it does not launch immediately, press the SMART Board ' icon| | located in the
Windows MNetification Area at the botlom right of your screen. Choose Show Floating Tools... from the
menL
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The border indicates the Digital Ink Layer is in place, and you can write on Lhe desktop just as you would

wnie on a transparent sheet. The Digital Ink Layer and itz visible barder remamn in place until all pen tools

and the eraser have been returned (o the pen tray and you touch the board.

Floaling Clear Capture
Tools foolbar Border writing  wifing
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Your first touch on the board, afier returning all the pen tray tools, will bring up -
a menu with cptions for capturing yourwriting, 1f yvou wish to hide this menu, click Save Ink

Ink Layer Options... and select the Close ink layer with pointer checkbox Always Save Ink

Trik | aver Opkions, ..

To save an image of the screen on which you were wnting into a new Notebook |~ "7~
page, choose Save Ink. To clear the writing but keep the Digital Ink Layer in Clear Ik,
place, choose Clear Ink. To remove the Digital Ink Layer and clear the wrting, Close Ink Layer
choose Close Ink Layer : =

Restoring your notes and drawings

If you accidentally clear your writing. you can restore it by pressing the Click here to
restore ink icon, located in the lower right of the screen. You can then use the Ares
apture button to save your notes.

Click here Lo
restong ik

i)
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If you de nol see the Click here to restore ink message or don't reach it bafore it E'R
disappears, pick up a pen tool from the pen tray to launch the Floaling Tools toolbar ar -‘
press the double arrows on the toolbar tab on the left of the =creen. Press the Undo
button to restore your nales and drawings.

Unclo
Dollon

Capturing your notes and drawings

If you wish to capture a specific area of your screen, press the SMART Board icon Ff? lecated In the
VYWindows Mofification Area at the bottom right of your screen, Choose Other SMART Tools » Screen
Capture Toolbar... from the menu to launch the Screen Capture Toolbar.

Area Capfure Freehand
tustian §— Caphire
bablon

F 3
[«] Capure to neéw page

|
oy Snrean

Capiurg Captura
herfton buttan

To capture an area of your deskiop, follow these steps:

1 Press the Area Captore button on the Floating
Tools toolbar, The Area Capture tool will appear e

2 Press on any corner of the area you wish ta
capture and, continuing to préss, drag the
selection box until it surrounds the entire area

3 Release your press and your selection will be
captured as a graphic into Notebook ™ software.
If Notebook software is not already open. it will open automatically when you caplure a portion of your
screan, Save your Notebook file by selecting File > Save
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'Review questions: Getting started

1 MName the three companents required to operate 3 SMAR | Board interactive whiteboard.

2 How do you know when the interactive whiteboard is ready to be used?

3 Circle the pen-tray button that launches the On-Sereen Keyboard.

4 Describe one way to hegin the orientation process.

5 How do you right-click on the inleractive whiteboard ?

& Circle the Screen Capture toolbar button you would use to capture an area of your desktop.

v Capture o msk age

T Mame two ways to restore cleared wriling.

i



Getiing started

[ 2 =
Review answers: Getting started

1 Name the three components required to operate a SMART Board inleractive whiteboard.

Inferactive whiteboard
Computer
Frojector

2 How do you know when the interactive whiteboard is ready to be used?

The Ready Light is a steady green.

3 Circle the pen-ray button that launches the On-Screen Keyboard.

4 Describe one way to begin the orientation process.
Fress and hold the keyboard bullon and the right-mouse button on the pen tray simultaneously.
5 How do you right-click on the interactive whiteboard?

Frass the right mouse button on the pen tray to have your next press on the interactive
wititeboard recognized as a righl-click.

X

[#] Capture to new page

7 Name two ways to restore cleared writing.

Fress the Undo butfon on the Flaating Tools toolbar,
Fress the Click here fo restore ink icon in the lower right of the acresn

12
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Hands-on practice: Basic functionality

Your school or company has just moved one of your SMART Board interactive whiteboards into a new recom
because you were unable to access the Internet from the old location. You will be the firs! person to use it
in the new environment and will be showing everyone how to use it and the Internet together,

You have learned through experience that whenever a piece of technology gets moved, it's a good idea to
test it before you deliver a lesson ar presentation. The compuler, interactive whiteboard and projector
appear to he working properly when you turn everything on, However, when you double-préss the Interne
browser icon on your desktop, your cursor appears a few inches away from your finger press.

Orienting your SMART Board interactive whiteboard

You remember that when the projector or interactive whiteboard moves location. you should arient the
board, This action will tell the computer where the image of the deskiop is being displayed on the surface
of the interactive whiteboard.

1 To onent the interactive whiteboard, press and hold the keybeoard bution and the right mouse button
simultanecusly until the Orientation screen appears

PRl
A

Hen-lray bottons

Ferr-fray bulfons

2 Begin the orientation process at the upper-left corner of the Orientation screen. Press your finger or
pen tool firmly on the center of each cross in the order indicated by the white, diamond-shapead
graphic.

Mreaz canler of Target and reloase,

2 o o

{he Creritalion screen

NHOTE: [he point is registered when you remove your finger, not when you first touch the Orientation
screen.

132
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Testing basic functionality

It's & good idea to test the basic functionality of your interactive whiteboard le ensure all the applications you
will be using to deliver your lesson or presentation are working properly,

1 Using your finger, double-press on the Internet browser icon (e.g. | Internat Expl{:rer@}l to launch the
Internst

2 Press lhe On-Screen Keyboard button on the SMART Pen Tray

3 Press once inside your Internet browser's address har to select the website address

A SMART Technologies, industry leader in i... [

File  EdiL  View Favorites Tools: Help
e o e
@ Fark |‘L; |£| @ II‘_\.:’J | 7 Search
; hall >

4 Using the On-Screen Keyboard, type www, google.com

Classic ~|| Seftings |[| ]| ()

J— - [ 5 o [

I‘:ﬂ q|w eir t y.u i__n p{[}]H Ins || pame| | POl

O GIS \'.'.'I!f g h i k |:;h' ! o=l || End || rgun

S zix|c|v”"EHh']m*,*_!?;““'{f t
ETJ ci | 7| An . alt ||%H||cm « |31+

NOTE: The On-Screen Keyboard is a single point of contact; tauch-lyping or keystroke combinations
are not possible.

5 Press the Go button beside your Internet browser's address bar

Addrass @ httplfﬁwvﬂi'.l;oolje.:orﬁ B -v l@

14
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6 You know you will be writing notes directly over the Google™ search engine webpage during your
lesson or presentation to highlight key points

Pick up a pen toal from the pen tray. You will notice the Digital Ink Layer appears, shown by a visible
border around the desktop. The border indicates you can write on the desklop, and it remains in place

until all pen tools and the eraser have been returned to the pen tray and you touch the board.

Digifal ink § ayer
bardar apnears

File  Edit  Wiew Favortes  Tools  Help

’ & - ] [—
_ ’@ Back = (2] (2] | ot Search
N L= 4 r

Lddress |ﬁj bk f v google, com b ! G0

7 Using a pen tool, circle the browser's Back button

8 Return the pen tool to the pen fray, and louch the interactive whiteboard once to clear the circle

around the browser's Back button. Press the Click here to restore ink icon at the bottom right of the
socreen to brng the circle back,

Click here to
restare ink.

)

You have now confirmed that you can clear your notes by touching the interactive whiteboard, then
restore your noles by pressing the Clear here to restore ink icon.

To ensure you will be able to capture and save important information for a future lesson ar presentation,
launch the Screen Capture toclbar by pressing the SMART Beard icon m located in the Windows

Notification Area at the bottom right of your screen. Choose Other SMART Tools... = Screen Capture
Toolbar... from the menu.

9 Preces the Area Capture button

Aveg Coplure
hutton —»

Caplure Lo ey pdye
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10 Press the interactive whiteboard and, withoul releasing pressure, drag the selection box using your
finger to outline the circle around your browser's Back button. Release your press Lo capture the
image lo Notebook software,

- Guopie - Miciosait internet Explorert

fiew  Fawokbiles

| -.-‘; 'rf"’:‘"‘-u i I.r-:-.-r

:;j |":‘1 o ¥ o= Search
: 1 $
; p:;l',l'l.-'\m.liu:'_-ugle.ccum v| = B

fools Help

NOTE: Notebook software will open automatically, and your noles and background will be saved to a
new Motebook page,

11 Touch the screen once to clear the circle from your browser's Back button

12 Select the unsaved Notebook file from the taskbar to view your captured image in Nolebook software.
Select File > Save |o save your notes for future refercnce.

16
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What is Ink Aware?

When software is Ink Aware, you can write and draw directly inlu the active file, For example, if you write &
note or draw something while using Microsoft™ Word software, you can save your Word file and your notes
will he visible the nexi lime you open it

17



Wiorking with Ink Aware applications

How do Ink Aware applications work?

Ink Aware applications recognize which area of the software is the active work area and which area is used
for bultons and toolbars.

P Ple Edt Wiew Inset Fomel  fuel Table  Window Help  Adohe PO

0,230 D A B L et op @ e

. . & Buftons angd
i ¥ [ Settings = % s ' ; ; £ ; fooliars

IEE---||||J_||||...2----|-.|5|--|---4’.---|-
i | | i i i i i

Trk Avare

What applications are Ink Aware?

Ihere are over a dozen Ink Aware applications, as outlined in the table beiow.

Microsoft Microsoft Word, Mi_trl::soft Excel® Openﬁﬁice Cale, OpenOffice 1u"-'."r*ite-r

Office

Graphic CorelDRAW®, OpenOffice DRAW, Microsoft Imaging, Gorel® Grafigo™ 2, Microsoft
applications Paint™, ArcView, Autodesk™ DWF Cormposer 2.0, Valo®™ View Express
Presentation Microsofl PowerPoint?, Corel Presentations™, Microsoft Office Live Meeling,
applications Microsoft NetMeeting™ 2.0/2.1/3. OpenOffice lmpress,

Other AutoCADT, Autovue™ Professional, Microsoft Windows™ Journal, Microsoft Office
applications DneNute@: Microsoft ViSLD(“"'. Adobe™ Acrobat® Professional 6 047 g0

This section will focus on the most commuonly used applications - Microsoft Word, Excel and PowearPoint.

18
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Microsoft Word software

When using Word software with your interactive whiteboard, you will notice four buttons, They may be
integrated with the current Word toolbar or separaled as a floating toolbar,

e i Fress to insert your drawings or writing as an image diractly inta your
= fgj Lj‘ 1 document
e R T Press lo convert your writing as typed text directly into your decument.
| | | 2 Your text will appear at the cursor point and in the color the words were
1. E Iri Ii written in

3 Fress to save a screen caglure in Notebook software

4 | Press to select the option to autematically insert the drawing as an
image

IT you do not see this toolbar, select View > Toolbars = SMART Aware Toolbar in Word.

E_x.fir'np[é_: Pressing the Insert as Image button

Before you press the ﬁutton, the image is not part of the Microsoft Word file. It can only be seen on the
inleraclive whiteboard,

_aoc - Wicresalt W : X
wah b T Table Wl heo

Bl Eéqrm.wm WA

- Eseeg o e
BMART Pen Tray
The pen ray consists of
foar color=coded slots S

preen laals and ocna slad for
e manar

Y our finger ks your mouse
£ prezs on a SMART Boad
interactive wlilohoord is the

“—

Press Lhe button and the image becomes part of the Microsoft Word file. Now, you can send suggested
changes to the appropriate person.

SKART Fenn Tray -
The pen broy consizty of
foun ealal-zedad slers for

pen teole and oas st o
Hie arase

Your finger 15 your mouse
£ oprecs ona SMART Eamd
ilsracthve wielehoard is the

é“-—-\-__

Innierag a5 imane = win.,

18
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Microsoft Excel software

When using Excel sollware with your interactive whiteboard, you will notice four new buttons. They may be
integrated with the current Excel software toolbar or separated as a flnating toolbar,

Ef-,'ﬁil'is. |:d|t Yiew  Insert

. 1 Press lo insert your drawings or writing as an image directly inlo
.ri—l-. l—f LE‘ _nf | j Q your spreadsheet
0t 08 e [
T 'y | Press to convert your writing as typed text directly into your
| | | 2 document. Your text will appear at the cursor paint and in th
i = & [&) ~ color the words were written in

3 Press to save a screen capture in Notebook software

7 Press 1o select Lhe option to automatically insert the drawing as
4’ an image

It you do not see either of these toolbars, selecl View > Toolbars > SMART Aware Toolbar in Excel
software

 Example: Pressing the Insert as Text bution

Before you press the t::ut.t-rzm, lhe image is not part | Press the button and the image becomes part of
of the Excel software file. It can only be seen on the the Excel software file. Now, you can send

interactive whiteboard, suggested changes to the appropriate person.

Eieronaft Excal - fnk bweare Facelxl

B2 i i el - Inkcwre Excel.ih) [Reatt-0nity] | |

'JUIM!WMKFWMLWMEMMM

Al SN ew geon Fomet Joos gwn wwese AR
e T e F0e N e [ SR N e E T I ' el ol S e e )0 PR X 0 R
oy | S
T " { 200

= R E T LT T :'_ """" CrEeT ru.n.wn-: 18 Tt [ E = i ] T
' |[Budgetrequests ~ Expected costs |1 Budgetrequests Expected costs
7 |Technalogy upgrades $10.000 |3 Technology upgredes  $10.000
| & |Professional development I:l | lplﬂf&"“almlﬂE[EVE’DPH!EI‘It
| & |Rescurce library | | £ Reszource llbrary

& |Staff hires | £ Staff hires

ELl il
+ 00 a

8 §: 3|
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Microsoft PowerPoint software

When you work with PowerFPoint software in Normal view on an interactive whiteboard, you can save your
notes as images and save screen captures to Notebook software, just as you can when using Word or Excel
software Ink Aware fealures can be aceessed through the Aware Floating Tools, which launches when you

start creating notes or make drawings.

Aveare Hoaling Tools

o to the previous Opan the Cammand nwen \Gc fo the next
slide i yaur

hide in your
presemntahon nresantation

VWhen you present with FowerPoint software on an interactive whiteboard, you can also save your notes as
images and save screen captures to Notebook software. Ink Aware applications can be accessed through

the Slide Show toolbar, which launches when you enter Slide Show view,
Shde Show toolbar

|
e Tgr
AR
Go fo e prevﬁousf Ooen the Command menle  Go to the next

slide in your alicle i yiour
presentabion presemtation

TIP: You can go fo the next slide of a PowerPoint software presentation byr pressing twice on the
interactive whiteboard, making the second press to the right of the first. To go to the previous slide, make

the second press to the left of the first.
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Warking with luk Aware applications

The Command menu
Frass the center butlon on the Slide Show toolbar to launch the Command menu,
TR

o

¥ Capture to Motebook,
Tnsark Drawing as Image 4——| 2
3 ® Clear Drawing

add Blank Slide —0 o 4

5 # PowerPoint Commands
= Settings 4 — | B
7 —# SMART Floating Toals
End sliow 4+———— | B
ni Capture an imacge of the comsnt siide Laurch the PowerPainf Commands
1 to Notehaok soffware 5 Sk
Save yaur notes directly inta yoor Launch fhe Seibings sobrmeny
2 FowerPoint software presentation 6
3 Delete your nofes from the page 2 Launch e Floabog Tools eolbsr
4 Add an additiona slive 1o yoor 8 End the shde shov
presentafion :

PowerPoint Commands submenu
Capture ko Mobebook,

‘ Tnzart Dravdng as Image
[ ClearDrawing 1
| idd Blank Slide |
=== S . |
|| PoweiFrink Commands || == B
| Sattings Elack/Unblack Scres |r i
Prink Slide o
| SMART Floating Tuuls s - i 3
i End Shaw | =l r _inerPumt Menu |

4

1 Skin fo any slide in your presentation

2 Make the sereen black

25 Print the comant siide an vour delawll pnnter
3 =

4 | Cpenlhe PowerPomi soffveere menu
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TIF: Use the Black/Unblack Screen command when you would like to draw the attention of.ﬂu;n;}ur class

or audience away from the screen and lo the presenter. Press twice in rapid succession anywhers an
the screen to resume your slide show exactly where you left off

Settings submenu

Capkurs o Mateboaok

Iraett Draime as image

Add Blank Slids 1
FowsrPoint Commands b l

set ; 13 Double-Press o Advance -
SMART Floating Touls v aave Drawing ab End of Showg—— ] 2

| » Transparent Toolbar
Frirl Shms ko i
3
To advance shdes with g Deselect Save Drawing at Peselect Transparent
1 sigle press, deselect 2| Endof Show if youl da ool 3 Toolhar i vou woult! e the
Dowulle-Press to Advance want ko be prampted to save tnnlfhar o be oragus

yaur potes
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Worhking with Ink Awaie applications

SMART Floating Tools

The Windows Operating System laskbar and notification area are hidden when you are presenting a Pow-
erPoint slide show. You can still launch the Floating Tools toolbar by selecting SMART Floating Tools fram
the Command menu.

=== ]

Capture to Mobebool, |

In=ark Drawing as imaoe |
Clamar Ciraedng |
Adid Dlank Slide |

) =|
PowerPoint Commands b |

|

Settings b

| SMRRT Fioating Tools ™ ) 1IN
Ered by .
B
TIFS:

1 Use the Ink Aware toolbar buttons to convert your notes directly in Microsoft Word and Excel
software

2 The Slide Show loolbar in PowerPoint software allows you to control a PowerPoint software
presentation while you are at your SMART Board interactive whiteboard

3 You can launch the Floating Tools toolbar during a PowerPoint slide show by selecting Slide Show
Toolbar > Command Menu > SMART Floating Tools
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Review questions: Ink Aware

1 Describe the function of each of the buttons on the Ink Aware toolbar that appears in Microsoft
Word software,

2 Describe how o inserl digilal ink as text into a selected cell of an Excel software spreadshest

3 Describe when in Slide Show view how to save writing on a PowerPaint shide into Notebook
software.

4 Describe how you would save your noles and drawings to PowerPaint software files.
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| Review answers: Ink Aware
i

1 Describe the function of each of the buttens on the Ink Aware toclbar that appears in Microsaft
| Word software

fnzer as mage: Inserts notes as an image info the document or spreadshest

» Insett as Tex! Converls notes info typed text and inserts them into the document or
spreadshest

Capfure fo Nofebook: Captures the wisibie active work area info Notebook soffware

Settings alfows drawings to be automatically insarled into the document as an image

2 Describe how to insert digital ink as text into a selected cell of an Excel software spreadsheet.

To save digital ink as text, press the Inscrt as Text button o the Ink Aware foolbar

3 Describe how lo save writing on a PowerPoint slide into Notehoak software.

Fress the center hutfon on the three-bufton Shide Show loolbar and select Capture to Notebook,
Bolh the slide and the notes will be caplured as an image fo Nolebook software,

4 Describe how you wauld save your notes and drawings to PowerPoirt software files

Fress the cenfer buffon on the three-button Siide Show foolbar and select Insert Drawing as
Image.

If you do not save vour notes and move forward o the next shide, you will be prompted to save
vour notes when vou end the slide show. This oplion can be deselected in the Settings submeny,
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Hands-on practice:
Ink Aware and Microsoft Word software in the classroom

Before you start
Before you begin your class, ensure that your computer is turned on and the SMAR | Board interactive
whitehoard is connecled and oriented.

This hands-on practice assumes you have a basic understanding of the Microsoft Windows operating
sy slem.

Preparation
Create a short. two-gquestion quiz. Ina realwoerld example, you would open a quiz prepared in advance.

1 Open a blank decument in Word

2 Type a mathemalical equation using your computer's keyboard — for example, 12 % 7 = Press the
Enter key several times to give your students space to show their wark.

3 Type Complete the following sentence with either “who' or ‘whom.” Press the Enter key twice, then
type Now is the time for all good men to come fo the aid of.

Using Ink Aware in the classroom
Your class has just completed the guiz you crealed in Word. Now you would like to review the answers as
a graugp.

1 Show your class how o besl display their work when answenng the multiplication equation Use a
pen tool from the SMART Pen Tray to demonstrate how to arrive al the correct answer on the
interactive whiteboard. Put the pen ool back in the pen tray, and press the Insert as Image button to
add the answer ta your Ward file.

: File  Edit View Insert Format
:lLff = = = e} f iﬂ}: ‘ir'-kr
| . [8) Settings ~ Ej

i
|
I CLASS QuUIZ
i Cluestion 1

|

I 13 %7 = '3{ %
|| 7\-’[

| A\
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Wiarking with Ink Sware applications

2 Move to the next guiz question  Discuss wilh your class when to use the word who versus whor in
the sentence.

3 Touch the interactive whitebeard {e place lhe cursor at the end of the sentence

L+ []

Question 2

Complete the following semtence with either “who™ or “whom.”

Bl 15 the time tor all good men to come to the aid of

<] PRSECN 5l

Question 2

Moy is the time for all good men to come to the aid of |

NG

<] |+

Complete the fullowing sentence with either “who™ or “whom.” J
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5 Press the Insert as Text button to convert the correct answer to text. The text will appear at the
cursor point and in the same color as the digital ink it was written in

: ﬁevﬁdﬁ- Wiew _ lnsul. ﬁ

O

Ouestion 2

Complete the following sentence with either “whn” or “whom.”

Meow 15 the time for all good men L come to the aid of whorm?

Jod |

-+
e

1 = pomg L Tl

6 Save your decument in Word. Now you can e-mail or print copies and distribute the answers to your
students.



Wiorking with Ink Aware applications

Hands-on practice:
Ink Aware and Microsoft Excel software in the office

Before you start
Before you begin your class, ensure that your computer is turned on and the SMART Board interactive
whiteboard s connected and oriented.

This hands-on prachce assumes you have a basic underslanding of the Microsoft Windows operating
system.

Preparation | k¢ thy () Seitings ~ %
1 Open a blank spreadsheet in Excel software b gy s |
I !
2 Type Hotelin cell A2 on your computer's keyboard | A, | B |
1
3 Type Flightin cell A3 2 Hotel |

3 fFiight  [__inool
4 .

4 Type 1000 in cell B3

Using Ink Aware in the office

Assume you and your colleagues are attending a conference in the near future, As a group, you prepared
a travel request outlining the anticipated expenses. This request will be presentad to the accounting
department for approval,

1 One group member states the hotel will cost $150 per night. Press the cell in the spreadshest to
highlight where the cost will be placed. Pick up a pen lool from the SMART Pen Tray and write 150 an
the interactive whiteboard.

|16 oy 0 st~

! B2 b 5
R T e o ) -
1= [ A
2 Hoel [ 1 -
3 |Flight 1000
2 | e
51
B | T
3
E | L
9 B
[10] -
i1 |
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2 Another group member declares the corporate rate for the hotel 1s only 5115 per night. Put the pen
tool back in the pen fray and press once on the interactive board to remeove 150 Then, press the cell
in the spreadsheet to highlight where the new cost will be placed Now, wrile 115

Lifs g T settings *ﬁ

B2 v A

Ao iierae ¢ | D | E
i :
2 [Hotel | 1 '
|3 [Flight | 1
I
5 i
E a
171
= P
9]

3 Press the insert as Text button to add the hotel rate into the highlighted cell, Your text is inserted into
the spreadshect and will appear in the same color as the digital ink it was written in.

i o
(2 JHetel [ 115]

| 3 (Flight __|____1000

4 Finally, your team lead suggests that you get a minimum of three price quotes far the flight. Circle the
flight cost in cell B3 and write Gef guote. Press the Insert as Image button o inser your note as an
image into your spreadshect.

2 et s i
Cnm eI

i

olm ~|o|mie|{w|n -
|
: O.| |3

§ Save your spreadshect as an Excel software file. Now you can update the travel request with your
group's notes and e-mail il 1o the accounting department for approval
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Hands-on practice: Using Microsoft PowerPoint software
on a SMART Board interactive whiteboard

EBefore you start

Before you beqin, ensure that your camputer is turmed on and the SMART Board interactive whiteboard s

connected and ariented.

This hands-on practice assumes you have a basic understanding of the Microsoft Windows operating

system.

Preparation

Assume your supervisor has requested a brief presentation on the topic of productivity in the office. The
preliminary work on your presentation reguires you to incorporate feedback and suggestions from your
colleagues. The final presentation will be presented to your supervisor.

A sample FowerFoint software file is available at www smarlech.com/mediaftrainingcenter!
sampleprasentation ppl for this lessan. If this file opens in your Web browser, save it to your desklop and

then reopen it.

Alternatively. open an existing PowerPoinl oftware presentation saved on your computer. The steps in this
hands-on practice will still be applicable to you when using your own presentation with an interactive

whiteboard.

Presenting on an interactive whiteboard
1 Select View > Slide Show to begin your presentation. The Slide Show toolbar aulomaltically appears

50 yOu can navigate between slides,

2 Press the Next Slide button on the Slide Show toolbar to move forward one slide Then press the

Previous Slide button to move back one slide

TiP: You can go to the next slide f.‘af a FowerPoint software presentation by pressing twice on the
IﬂtE‘FEICtWE whiteboard, making the second press lo the right of the first. To gu io the previous slide, maks

the second press to the left of the first.

Company Strategies
Bringmg fuli productivity to your arganization

f=—1%

Fress wice, & sacond rass o the right will move
to the nex! sfide.
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Company Strategies
Eringing full productivity o your arsanization

“ectinginghiy

Freag iwice, a sacond prase i the iaff will nnowe
fothe previolis slide.
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3 Advance the slide show by pressing twice on the interactive whiteboard, remembering lo make the
second press to the right of the first

4 For emphasis, you want to draw your audience's attention to the items listed on your PowerPaoint

slide. Pick up a pen tool from the SMART Pen Tray and place a check mark beside each point as you
discuss it wilh your colleagues.

The Hidden Productivity Problem

What infrastructure do you
kave at workstations?

1. Computers "
2. Metwork connections/
3, Software -

With these tools, people
sfay productive

ok 2.
| E T

Toarrakaprs

5 After the discussion, you decide to remove the check marks. Retum the pen tool to the pen tray and
louch the interactive whiteboard once with your finger to clear your notes

& llze the Slide Show loolbar, or press twice on the interactive whiteboard to advance to the nexl slide

7 Your colleagues take interest in the statistics you referenced on your PowerPoint slide and ask you to
send them the source material, Record their request as a nete to remind yourself to get back to them
later. Pick up a pen toal frem the pen tray and write send source matenal,

The Hidden Productivity Problem

+ Hew long do people spend
- away fram their desks par
manth?
= The average prolessicnal
spens:

— 40 hours in meetings and
prasentatinns aach

manth’
~ 7 heurs in training each . :
month SEND SouRGE MaTeRIAL
______,fnk__ﬂ.,f'”'___-__-_"____ -

At 10 Slan ¥esing Like Thic | bosvick & Felwan) UEE Deplood Lab:ﬂuwu.'_big_gu'ﬂ

8 Relurn the pen tool to the pen tray
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9 Since you want to fellow up on your note, but you den't wanl 1o save it as a permanent part of your
presentation, press the Menu bulton on the Slide Show toolbar and select Capture to Notebook fram
the drop-down menu. Notebook software will open automatically and an image of your PowerP aint
slide with your written reminder will be inserted inte a new Notebook file.

B Unkitled - SMART T, .

p New Nofshook file

Inzert Drawing as Image
Clear Drawing
Add Blank: Slide

FowarPoint Cammands

setlings
SMART Floating Tooks

Erad Sk

10 Now that your reminder has been caplured to Notebook software, press once on the interactive
whileboard to erase your note from your PowerPeint software presentatinon Advance to the next slide.

11 The next slide in your presentation requires feedback from your colleagues. Pick up a pen teol fram
the pen tray, and record their suggestions.

IMeetings That Work

+ \What iz involved in a
praductive meeting?

l. Time ManAGEMENT

7. Nerve PasricipaTtien]
By A MEMBERS

S Revevant Teres e
Discossron

4. PrepaREDd AcenDa

12 Oops! After putting the pen toal back in the pen tray, you accidentally bumped the inleractive
whiteboard and your notes disappeared. What if you had wanted to save that information?

Before you pick up the pen toal again, press the Click here to restore writing icon that appears in the
bottomeright corner of the screen. Your notes will reappear on the slide.
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|
! Meetings That Wark

+ \What is involved in a Capbure bo Hotebook,
productive meeting? Insert Draving g D

: Restore Draming s
Add Blank Slids

PrwrarFrint Commanids

setiings
SMERT Floating Tooks

Ercd Shaowy

O T

- TiP: If the Click here to restore writing icon disappears from the interactive whiteboard, don’t worry.
Click the Menu button on the Slide Show toolbar and select Restore Drawing.

13 You are ready to end your presentation, Press the Menu button on the Shide Show toolbar and select
End Show from the drop-down menu. Select Yes in the SMART Aware message box 1o add your
notes to your PowearPaoint software presentation

14 Select File > Save to save your notes into your ariginal presentation, or select File > Save As 1o save
o a new PowerPoinl soltware file. Close your presentation.

18 Now select the unsaved Noteboak file created earlier in the lessen. Select File » Save to save your
notes for fulure reference.
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What is Notebook software?

Motebook soltware is SMART s interaciive whiteboarding soffware. Use it in the classroom to create
engaging and interactive lesson activifies.,
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Basics for Motebook softwars

Using Notebook software for the first time

To launch MNotebook software, double-click the SMART Board interactive whiteboard icon on the
desktop. Or, click the Start butien in the bottomn left of your screen, and select Programs >
SMART Board Scftware > SMART Notebook. The Welcome fo Nofebook Sofiware screen will appear. If
you do not want 1o see this screen next time, uncheck the Show thiz when Notebook opens check box

% Bl Motebook Dle s%—; Ciriet

| % Qper Cagstinig File };& Control Panel
& f’i}‘}_‘ SLart Conference By Change Langusges

Fecently Opened MNotehonk Files

S Modules MNEO |5 TTapcid
L vP-Welcome v

SMART

Tothinolsgies

When you click New Nofebook File, a new file will open. Each new Notebook file contains a Work area that
can be filled with objects. Handwritten notes, typed text, graphics, clip arl and Flash® files are all examples
of what you can add to a Notebaook file. A key feature of Nolebook software is the ability to add as many
pages as you need to capture or display information.

'_mﬂﬁl'llll'ii f?ﬁijﬁ‘iﬁﬁw"”‘"mrﬁ?f‘rﬂr&*__ﬁ.—:_w.w_,, T e e e T T T AT wg—-s;--—?—_.,—m = '
_I‘_.h___&,\l. HM } Iossrl Poamet Dreny Heh _____ = sl SR Y s Sl e A, ; |
2 2HIBWERICTRAEDE RS/ LI By ZRA M
3 —cr— Lﬂﬂ
R Sl

| TS E— :
= i
| | e
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Notebook software menu bar

The Notebook software menu bar provides access to many of the same tools and features found an the
Motebook software toolbar, and some additional tools, Click on the menu item you wish (o access.

.} Basiclotebook * - SMART Notebook

F

i Fle Edt Wiew Insert Format Draw Hl-alﬁ 4 Menw bar
Menu item Functions
| File * Open new or existing files

Save afile

Save As — save a file for the very first time, save a file with 2 new name or zave the
file In a new location

Save the current page as a Gallery item

Impaort a vanety of file formats

Export content to a variety of file formals

Frint files or modify pnnt settings

send a file to a mail recipient as a Notebook file or a POF

Timed Saves — select how often you want your file to be automatically saved (itis a
good idea to set this to 15 minues)

See a list of recently opened files

Edit

Undo or redo previous actions

Clone, cut, copy. paste or delete selected objects or all objects an the page
Ldit a text object

Select all unlocked or all lscked cbjects on the page

Clear or delete the current page

! Wiew

Change the current side tab view (Page Sorter, Gallery, Atlachments)
Move to the next or previous page

Launch the Screen Capture or Screen Shade tool

Hide the side scrollbar

Cuslomize the loolba

Change the view to full screen

Zoom to magnify or reduce your view of page contents

Show All Links

Select the language Motebook software displays

Insetrt

Add a blank page, a picture, a graphics file. a Flash file, a Flash video file or a Gallery
item. Add a link, a sound file or a tahle

38



Basws for Molebook software

Menu item Functions

Format + Change font styles (bold, underline, italic)

*+ Sel object properties (color, line width, line style, fill, transparency)
« Lock object properties and position

» Infinitely clone a selected object

+ Change the background color of a page

+ Create or set page themes

+ Set alignment guide defaults

DCraw » Group, ungroup, fip or order objects

« Select objects

= Access Pen, Craative Pen and Eraser tools
» Create shapes and lines text

« Select the fill tocl

» Selecl a default font face, size and color

Help = Access the Molebook software Help file

« Check for software updates

+ Participate in the Customer Expenence Program

« Access information about Notebook software

TIP: You can élsn access the Notebook software menu bar drop-down menus by holding down the Alt
key or the Ctrl key, and tapping the underlined letter in the menu item (e.g., Edit is Alt + & and Save is
Cirl + s),
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Notebook software toolbar

The Motebook software toalbar provides access to a number of tools to help vou waork with vour Notebook
file. By default, the toalbar appears at the top of the Notebook page. |

€500 |IROCX | TREDED

Use this tool to

Display the previous Notebook pag_]e .

Display the next Motebook page

Button | Use this tool to

ati

Insert a table

Select any abject on the page with your
finger or mousa

insert a blank Notebook page directly
after the active Notebook page

Open an existing Notebaolk file

| Write or draw on the Notebook page with |

S

Wrile or draw on the Notebook page with
the pen tool

the Creative Pen tool

Save your Notebook file

]

Q

L
-

Erase digital ink on the Motebook page

Paste copied object({s) into a
Notebook, file

Undao the lasl aclion you performed

| Draw a line

Create a shape

Redo the action you performed

Delete any salected r:ubjed_:

Draw a shape on the Notebook page with |
the Shape Pen

Showlhide the Screen Shade an the
current Motebook page

| Use the Magic Pen to zo0m and spatlight,

of wiile in disappearing ink

Use the current fill effect to fill an object

Cpen Full Screen view

Create a text-entry hox for typing

Launch Dual Page Display

2> e N & | R

Launch the Screen Capture toolbar

| Activale the SMART Document
Camera

Miewe foolhar
foreia faol t

Sedect oo k

W edify pmperfies of a selected object

Move the toolbar to the bottom of the
Motebook page

By default, the toolbar appears at the top of the Notebook page. If you prefer, it may be more convenient to
move the toolbar to the bottom of the page. To do this, click the double-ended, vertical arrow on the far right
of the toolbar
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More toolbar choices
When you click on some toolbar buttons, you are offered more options for creating Nolebook objects,

. PalaWaPe s ar )

o |- < > B¢
o BLITADNSIOIOIAIONAIGIVIX
gt [P

pern too! ane 10l

Tewt tool A I ,,:
e | Mia m=

Ergzer 7

ool s
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Side tabs

Molebook soflware raining for SMART Board users lavel 1 learmer workbook

There are four tabs on the side of the Notebook interface. which are shown below on the right-hand side of
the work area. Click the double-ended honizontal arrow to move the tabs from one side of the work area to
the other. You can hide the side tabs from view when you have finished working with them by checking the

Auto-hide checlk box.

|
|
RETE S

Page number.

Mage thumbnai

Dopbile-vlick fo
chiamge e ngme
af the pane.

Inerease e
vedtfy af e fal
CEpEY HIEE,

Fage drop-dows e
menu

Woaork area

Aitc-hide chack Box

e

. -
|
: GFroups ial.
i [ = .—_] L;l Page Sorter tah

- |

|-t Groupl. b ¥

e
- WL i |
- J " L) Gallery tab
I l
Apt BELD02 A0

Aftachmants fab

et [ ] Buto-hide

: EEA Froperties fab
iy B
Move fabs o

@ | ihe other side
£ of e weork

HILE,

.@'-‘_ _ Previogs o
‘__Nexf i lp

lEj < | Add apaga

:'.'.’_ 4 Uhoio fast achion
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Basics for Motebook softwanz
Click the Page Sorter lab (o see a thumbnail image of each page in the Notebook file, navigate o a different
page or reorder the pages,

Click the Gallery tab to access collections of SMART s custom pages, clip art, Flash animations and video
you can add to the Notebook file,

Click the Attachments tab to add hyperlinks to or attachments from other software applications to the file.

Click the Properties tab fo formal shapes, objects and text,

Page Sorter tab

Click the Page Sorter tab ta see thumbnails of all the pages in the Motebook file. "y
1%
The active page 1s indicated by a second border around the thumbnail image and a l ,|
drop-down menu. Clicking ancther page in thie Page Sorter tab area makes that page =D
active, and its contents are displayed in lhe work area. To change the page order, drag o
and drog the thurmbnail of the page into its new location.
53 M
Lelete Paos Dl | Tha sacard = oA
Clear Page ChrlL horclar Indicates ;['1' _uj""#-x
Insert Blank Page  Clrlim the active page \ "[ ® |
W | ChonePage A A l

Ranarne Page

Soreen Shade
Show Al Links Ak
Add Page ko Gallery

El | Lh

lnaaae AN
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Page Sorter drop-down menu
Clicking the drop-down menu on the active page presents you with eight options,

[ Menu itemn

Function

| Delete Fage

Deletes the current page

Clear Page

Clears all the objects on the current page

Insert Blank Page

Adds a blank page immediately after the active page

Clone Page

| Rename Fage

Creales an identical page, including all objects on the page, and inserts it
immediately after the active page

Allows you to rename the page

| Scresn Shade

Covers the active page with the Screen Shade

Show All Links

Display all existing links on page

Add Page to Gallery

Adds the current page o the Gallery

Gallery tab

The Gallery in Nolebook software helps you quickly develop and deliver lessons in rich
graphic detall. Thausands of images, pages, videos, Flash files and enlire Nolebook files
arg organized into searchable collections that will allow you to create attractive, reusable

lessons,

Ivpe o seerch for Galiery
conlent by keyword.

Click o wiew your ¥
previous search —p !Iyp&- search tetins hers [V ﬁ-} o

results — works ina
rrEnner sirier to en

Iriberoe) Drowser's Beck
Eraatlor),

Ciick o @ colfection, and
thurmbnall imanes of its
ceorifent will he displayed
i the fower Gallsny
Wit

P

=[5k Fseentials for Educators @]  a
Hfh Administration and Evaluatic
[o]ee Arts
W:kl English and Language arts
F-0Ed Ganqraphy
Iil Histary
I:-!-I Mathematics
-G Paople and Culture il
[i%] ' ) ¥l

Eccentials for Educulurs
5417 items

Rictures and Backgrounds (3915)

Interactive and Multirmedia (511

G ol [, B 4

MNotebook Files.and Pages (9913
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Finding Gallery content

There are lwo ways to find content in the Gallery. The search field at the top of the Gallery tab allows you
to search by keyword — much like using an Intemet search engine. You can then browse the Gallery
collections by selecting a folder.

Te search for objects in the Gallery using the search field, follow these steps:

1 Click inside lhe search field
2 Type a keyword related to the type of obiject{s) you are looking for
3 Click the search button to display vour results

: — - G x Clicsk here to import
4 o |mapoof africa s 2 Fa contanf info the My

7o [, :\} Content ares of the
Q SMART Learning Markelplace = Gallary Collections

£ My Cantent

(2 Online Fzsmntials for Educators
£= Themsa

,‘5’_} Essentials for Fducatars — ;
i == Gallery Samplar ___.\ Click the magnifying

[+

==l

b Search Results for map of africa | S glass o view search
2 o ffé resultz in tha lowear
e | | G inc
L m B alleny window
' A
Search Results for mmap of D | (==
africa h
14 items ,‘r?

ok | Related Folders-(4) ] e

o ::P:r.h_lras and Backarounds {10}

f : i Select o
=] flambrail amd
& L drag if to the
) wark area.

africa Cote d'Tvaira
Dem. Rep. af Dijibouti
Congo

] Auto-hide
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Alternatively, you could browse through individual collections if you were looking for all the abjects related
o a general lopic. such as Geography.

# Adrinistration and Evaluation
[# Arts
b A English and Language Arts

=t Jgd Geography Iﬁj

I+ Flags
Landscape
L= Maps
- History i)

Geography
G4 tems

i !Pic_tures -anci Backgrounds {&84)

¥ Interactive and Mulimedia {2)

- Nu:utel:_u:ualx_.-FiIe's_and Pages [153)

Tip: Search a singular versus a plural term for better search results,
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Objects in the Gallery

Objects are organized in the bottom area of the Gallery by
Fictures and Backgrounds, Interactive and Multimedia,
Motebook Files and Pages, and Relaled Folders.

Double-clicking a folder thumbnail in the Related Folders
area will show all the cbjects contained within that folder,

Pictures and Backgrounds contains backgrounds and
abjects, e.g., graphics, pholographs or text. You can drag an
abject to the work area to use as part of a lesson or to madify
its properties. Drag a background to your Notebook page and
the color and design of the page background will change to
match the properties of the background Gallery item
Backgrounds are recognizable by the folded edge in the
bottom-right carmer and will always be inserted behind all the
objecls already on the Notebook page.

Interactive and Multimedia contains Flash objects, video
files and ohjecls with sound attached. Objects from this folder
are used to add nch media content to a lesson or presentalion.

Additional files and pages can be found in the Motebook Files
and Pages sections of the Gallery, Notebook page thumbnails
are identified by the folded edge in the lop-right corner.
Notebook files are recognizable by the coil binding an the left
of therr thumbnail images. Dragging a page or Notebook file to
the work area will inserl a new Motebook page or series of
pages directly after the active page.

Fictura Bavhground Mntahook Fage
| ot O
| = |
| s |
B |
O n
Flash object Auclion alip Wideo ciip
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Cnline resources

e sach einshee [l T

%
&

i 'ﬁ_SMAF.T Learning Markeiplace E;]
Fopl My Content

: = Themes

& B Gallery Sampler

Eszentials for Cducatars
| assnn Activity Toollkit 1.0

SMART Learning Marketplace

Downlnzd all af the cigeal
contart ¢ou naed from one
anline looetior, Tod can cearsh
tor Marketplace content didectly
srerm Motzocok then simply chek
ard drag the files onio a
Yolebook page.

My Content
The My Content area is a Gallery collection reserved specifically for abjects you have imported, captured
or created. |t is a good place o store objects that you will use in multiple presentations. To add an item to
the My Content area, drag an item from the work arca to the My Contant area

Click the SMART Learning Marketplace or Online
Essentials for Educators o access additional Gallery
content and open education resources from the Internet.

These onling resources require an active Internet
connaction and a Web browser,

The SMART Learming Marketplace is available by

sybscnption.

If you oflen use a particular page layout, you can store a Notebook page as a thumbnail in the My Conlent
ared. All the objects associated with the stored page retain their properlies. To reuse the stored page, drag
its thumbnail fram the My Content area o the work ares,

You can also store an entire Noteboaok file in the
Wy Content area. You might do this if you wanl
to give a presentation multiple times. To launch
a Moteboaok file from the My Content area of the
Gallery, drag it to the waork area

To import other Motebook files from your
computer, follow these steps:

1

2

3

4
5

Chek My Content and click the down
alTowW

From the drop-down menu, click Add to
My Content to launch the Add lo My
Content dialog box

Browse (o the file you would like to add
Click the file yvou would like to add
Click the Open bulion

Your file will appear as a thumbnail in the My
Content area of the Gallery
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Attachments tab

Make your presentations and lessons more cohesive. The Attachmenls tab allows you to e

link to supporting documents, software and webpages directly from your Notebook

software file. The Attachments tab is also a good way to store documents or websites in :‘”;/’:}-‘*

your Motebook software presentation that you might want to use in your lesson.

Toinsert a copy of a file, click the Insert button at the bottom of the Attachments tab, select Insert Copy of
File, and browse 1o the file location. Click on the file and click Open. If you drag a copy of file attachment to
your page, it will become an object with a paperclip icon in the bottom- left corner,

File Mame. . | Ciffercol unds of allechments are reprasantsd
EE':- . i ‘ L ; by gifferent Joans in the Attachrments sids tal.
aws, et
i, Sanple pd
B
= i Yocabulary. doc ]
i . L .
== Government, nolebook
I
; BA Quiz.doc
s o] x,
= % ‘
SMART education solutions
- [
A tife icon and a hypedink fcon as they
wolld spoear an the work area
e
3 !
:
[ ] &utn-hide | Insert Copy of File |

| Insetl Hyperfink I
| Insert Shorloul 1o Fle

e —

When you have an attachment associaled with your presentation, the appearance of the

g Aftachments tab changes o remind you the attachment is there.
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To enter an Internet address, click Insert Hyperlink. type the Intermel address you would like to add and a
Display name Click OK

Insert H ypt:-flmk i

Hyperlink:

| hittp:feducation. smarttech, com |

Cisplay name:

| SMART Eduration - i

Enter the URL you wish 1o link. Enter the Display name that will appear
on the page, Click OK,

There are also occasions where you may want to open a different software application, such as Microsoft
Word or Excel software, while remaining in Notebook software. At these times, you will want to insert a
shortout to a file. These files will usually be “executabls,” that is, they end in .exe.

Sharing your Notebook file

There are several ways you can share your Nolebook file with colleagues that are using Notebook software.
The eags=iest way s to save your Notebook file {select File > Save), and lat tham browse to it

You can alse share your valuable conlenl by selecling File » Export and save it as 2 webpage for Internet
users or anyons who does not have Motebook software installed on their computar The content can also
be exported as a series of image files or a PDF. Export your Notebook file as a PowerPoint software file if
you want to add transitions to your slides

Fle Edit View Insert Format Draw  Help

Pl CErl+H1 ¥ ey MO <
LRt T ChelD : _____4 =

Irnpart keI

{2 n] g8 Web Fage... !
Timed Saves Limage Files, .. I
= PR, ..
Prink Chrl=p :
PowerPaint, .. ‘

Gend To b

51



Basgics for Maotebook softwans

The Properties tab

When you click on the Properties tab, the properties shown are dependent on the type of
object you are working with at Ihe lime. You can change the Line Style of a Creative Pen
object. However, you can change the Line, Fill and Text styles of text objects. The
properties associated with each type of ohject are shown below.

: Remember, to salecl any object by clicking with your mouse, you must first click on the Select
k loolbar button.
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Change Fill Effects

You have many options when you change the fill color of an object. Two are shown below You can il an
object with a pattern or an image. You can alse change the fransparency of an object.

| Fill Fffects |

Fill Effects

[.. _ :"__J;age HE:nrdlng | ity |

|
,‘

2
z

() Gradient fil

Db]eu:t transpa.rerpcy

(i Image il £ ' @ = RS e

() Pattern .I’_iII

(3 Solid il

‘ () Gradient fil

{JPatterm Fl
iimage fll

Equwﬂ'

EEEEEEE®R
| Bl 8 08 Bof
m Bl I B

oAl BT ]

En]mﬁ'mr_j

ENEEEEEN

:Imﬂlﬂlﬁﬂ
ﬁﬁ“ﬁlﬁ

Salid fill
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Change Text Style

When you click on a text ohjecl, and click the Properties tab, several Text Style oplions become available.
You can select the Font, the Size, and the Font Style.
Just click on the drop-down armow, ar click the Bold, ifalics, Underlina, SUserscript o subscript DULEONS,

: e e R
g Text Style |
—_— e = Y
| L ooctanimaion ] (i
¥ o ! /- .
i 1;r.r&es Nt:;\.' Raman _:. el
_ S S TS i) i EA
Q Size g P
T - i I ——————— . =
i Weleomne o Alricu | - 18 ¥
i S S S R .O_ deRty : +*
el
By
: oo
e
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Change Line Style

When a line object is selected and the Properties tab is visible, you can change the color, thickness, style,

starting format and ending format of a line.

I

DA L Rl e

i
Line Style

B e TNEaa=L)

Thickmess

Line style

e 1]

End

[ ] Auto-hide

Xedt
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Review questions: Basics for Notebook software

1 What are the four tabs in Motebook software?

2 Desocribe how to move an object from one Motebook page to another.

3 How do | add a blank page to Notebook software?

4 Why would you change the location of the tabs or toolbar located in the Notebook software?

5 Why would you use the Attachments tab?
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Review answers: Basics for Notebook software

1 What are the four tabs in Notebook software?

Page Sorler. Gallery, Attachments, Propertics

Describe how to move an object from one Notebook page to another.

To move an obfect, drag it from the work area lo a thumbnail in the Fage Sorter.

How do | add a blank page to Notebook software?

Fress the plus sign button on the tactbar. or seledt the drop-down menu on the Page Sartertab, and
select Insert Blank Page.

Why would you change the location of the tabs or toolbar located in the Notebook software?

Tabs: team-teaching: right-handed or lefl-franded user
Toolbar: appropriale height for presenter or participants; ahility to see top of workspace

Why would you use the Attachments tab?

¥ou might wse the Attachments tab to link fo files and wehpages that you would ke to reference
during a presentation or lesson. If the files or webpages are linked from the Attachments tab. your
presentation will be more cohesive because you will not need to spend time searching for the
appropiate fle or program on your computer.
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Hands-on practice: Basics for Notebook software

Launching Notebook software

Launch Notebook by deuble-clicking on the Nofebook software icon on the desktop
IT the Weloorme o Notebook Soffware window appears, click on Mew Notebook File

Editing text

3 Click in the work area, and type your name. Your name appears in Times New Roman font face,
plain style, 16 pt and black color,

Fonts =
e ;,.g
\\\\“*NQ-:\x‘\‘u\M‘Q\\\\\\\k\\\\\\\\\\\\\\E\KK\\h\\k\&&&\

M our Name Q
\
\‘x\'\*u."\“Qx\\H\“{‘\\\‘\KK\K\\R\\\H\K\\\\K\\R\\H\\H\\H\HﬁR\\\\\

|'I-’j_1 Times Mew Roman v}: ‘1Ellv| B 7~U H
L8

Click the Properties tab, and then click on your name. On the Properties tab. click on Text Style.
Change the font, the size and the font style of your name.

o
oo |

Your INane

O

Click on Line Style on the Properties tab. Change the color of your name. Click an the Save icon
on the toolbar, Choose a name for your file. and click Save.

H IL;'H
Your IName :

O

Click twice on the Add Page icon on the toolbar to add two more pages to your file
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7 Click on the Page Sorter tab. You will see your two new pages. e
Page three is now the active page, and it is empty. Your name [ Groups ] e
remains on page one. Click on the second page | [-V_V__J

: et
T e rF"ﬂ]
i--v--ﬂ.
1
Apt 25-1:07 Phd

12 |

Apr 25=1:08 Phd [
e A
:]3
Apr 2SR P

Creating a line

8 Click on the second page. Click on the Draw a Line icon on the toalbar Draw = line in the work
area. Click on the Properties tab. Click on the Select icon on the toolbar. Click on the line Yo dresa
In the work area. It is now the active object on the page. Click on Line Style on the Properties tab.
Change the color, thickness, style, start shape and end shape of your line. Click in the work area.
Save your Moteboolk file,

9 Click on the Page Sorter tab. Click on page three,
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Creating a shape

10

Click on the Create a Shape icon on the toclbar. Click on the star shape on the subtoolbar. Draw a
starin the work arca on page three. Click on the Select icon on the toolbar, Click on the Properties
tab Click on yaur slar. Your star is an active object on the page, and Fill Effects are active on the

Froperties tab. Change the fill coler of your star. Click Line Style on the Properties tab, Change the
color, thickness and style of the line border or your star. Click in the work area, Save your file.

Adding Gallery content

11

12

Click on the Select icon on the toolbar. Click on the Add Page icon to add another page to your
file. Click on the Page Sorter tab. Page four is now the active page.

Click on the Gallery tab. In the Search

window, type hean plant, and click on S8 adn et | 82 Eﬂ

lhe Search icon, or the large g SMOART Learning Marketplace s

magnifying glass. £ My Conlenl |
<L} onling Fesantizls fur Educotors [==
<= Themas (|
] Essentials For Educators —]|
=130 Lessnn Achivily Toolkit 1.0

= Gallery Sarmpler éf;/

& Soarch Results for besn plant =)

U]

Zearch Results for bean e
plant s . |
1 ik&am

| 4 Related Folders (1) ] sr
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13 Chick on Related Folders and click an the Plants folder, Click the arrow on the folder and click
Cpen. Click on Pictures and Backgrounds. Click one of the piclures, and drag it to the work area.
Your picture is now an active object

Zearch Resulls for bean plant
1 itern

; . —y
| o }HElated_FDlders L= S T  [xlE o
= e | Ia:.,_J .
= i diclogy o
G LY
Gl |
] Food chass | r,—._ |
- Froquts | B
tarman hardy |
Life processes |
Flants =] C&_\/ i
i R 5 chemistey [l s |
Plants ; | S i
it E A |
Flarits ||| e |
A1 ilermes
A b L= A
L.d Hictures and Backarouinls (25) 2| | :
o i k=l ]
b e & .
_..If‘_,'.-! - |
— i -
o |
- = :
Arrovibead Bean 1 |
|
3
B a
: w"-a ; N ] E
% L. I
Bean s 2aan 3 = |

14

15 Click the Page Sorter tab. Drag page four so it will appear immediately after page one.
NoTE: When you drag a page to a new location, a solid bar indicates the new position. Save your
file,

16  Share your resulls with your colleagues. Close Notebook software by clicking File > Exit.
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What is an object?

Al text, images, audio, video and mullimedia are considered objects in Notebook software. You can change
the properties of these obyecls (o make your presentation more effective.
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Manipulating objects in Notebook software

Anything placed inzide the work area is considered an object. You can add an abject fo a Notebook page
using any of the following methods:

= Typing text

« Drawing or writing in the work area with a pen toal

+ Creating a geometric shape with the Notebook software toolbar drawing tools
= Inzerting content from the Gallery, a computer, or the Internct

Modifying objects
Select any object on the Motebook page to change its properlies, Selected objects have two handles. Use
the solid handle Lo rotale the object and the clear handle to make it larger or smaller

RER B aare A — > | ik for the drop-dow reny
coumteriocknise to . ¥
rotate obect ; S| RO | B

:: S Clone CrrHD
oo ik
E’ { o Copy CrlbC
! ! Paste Ctrly
| Delete Del
E E _heck 3peting
!‘ i Locking 3
arcpir ¥
i Flip ¥
i i !
5 d
i i Infinite Cloner
E’ Uk,
: .: Sound. ..
| ; Properties, .,

Crag to resire the alject

- ——;‘:\, 4 Drag toresize the abject

Dirag to rofate the object
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Moving objects
To move an object from one page to ancther, ensure the Page Sarter [ab is aclive and the Auto-hide check
box is not checked  Then click on the object you would like to move and drag it to the appropriate page.

[ LiraLpes

[ Groupt

I’ ﬁ“‘f

| 1

Epr 25146 P

i
>

EpT 25147 1A

=

Cirag from e solive page (page one) to page three, |
Bor 25147 Fhd

You can also move objecls using the Cut and Paste commands from the drop-down menu and the menu
bar. Click on the object to select it. From the object drop-down menu, click Copy if you want to keep the

ariginal object, or Cut if you want to remove the original object. Click on the page you want the object to

appear. From the drop-down Edit menu on the menu bar, click Paste.
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The Alignment Guides

The Alignment Guides allow you to control the placement of objects on your page, so objects can be placed
exactly where you want them to be. Click Format, Alignment, from the menu barto set the alignment guide
defaults,

#;,_Iignment;ti |

[v] EHQW guides for ackive ohjects

+| Shaw vertical page center guide

Show hotizonkal page center quide

[]5nap objects to quidas|

Bde color

I_[ | | T |

Lings mark tha canfer of vour page

Cliek an fhe Guide color kox to change the colur of the guide lines.

Nopr MName  Your Mamie Your Mlame
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Object drop-down menu
The object drop-down menu gives you one-click access to an object’s properties.

ltem Description
Clone Craates an exact copy of the objact or objects next to the original object
Cut Removes the selecled objecl rom the Nolebook page and places it on the clipboard
Capy Creates an identical copy of the selected object
Paste Places the object from the clipboard onfo the Nolebook page
Delels Deletes the selacted abject
Check Spelling | Checks the spelling Tor (he Lexl ehjecl(s) selectad -
Locking Frotects an abject or an entire group of objects from editing Ch{m:-ae between Lock In
Place, Allow Move, and Allcw Move and Rotate. ‘
Grouping Group two or more objects to act as one object Select, change, move, delete and
resize a group as a =ingle unit, To edit or resize the objects individually, ungroup
them,
Flip Flip an object either horizontally or vertically
Ohreder Change the order in which objects are layered
Infinite Clorer Make unlimited copies of an object on a Notebook page. Select and drag the objoct .
- ta create as many clones as required.
Lirk Link an object to a website, anather Notebook page, a file on = C{'.-rnp_uger o1 a file, |
such as a video clip or other mullimedia element, residing in the Attachments tab
Sound Attach a sound file to any abject
Properties Change the vizual characteristics of any object you've created in Notebook software
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Criwect drop=down many

Clone Chri+D |
L, Chel43
Copy bl
Paste iy
Delete [ra!

Check Speling. .

Locking
Erauping
Flip

T T v W

| Infinite Claner

Lirtk...
S,

Properbies. .,

Locking objects

Locking an abject allows you to protect the properties you have applied to it. The choices in the Lacking
submenu allow you to determine the type of lock to use on an object.

PP H =

Clone k-0
Cut Clrl s
Copy e
| Paste Chrl
: Dslete Dl
E ol Sp g,
P Locking' ® = e e Unlock Chrl+]
E gy B LockIn Place ChelHk
E Flig b Allow Move
B . | Crdur bl Allow Move and Ratate
i L = Ry e
e e e e e e s e e e No— Infinite Clorar
Link. .,
Sound, ..

| Proparkes, ..

Click the Lock In Place option to ensure the object cannot be altered or moved in any way.
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Click Allow Move to let you move an object, but not resize rolate
or change any of the object's properties. You might use Allow =g
Move if you were creating a Notebook file that would be used to 2
teach ordering, but wanted to ensure all the objects on the page
remain the same size.

Lock oo

Click Allow Move and Rotate 1o lel you move and rolate an
object, but not resize it. You might use Allow Move and Rotate if
you created a Motebook file with a puzzle component and you
wanted your students o arrange the puzzie pieces. You can
place the puzzie pieces wheraver you wish on the Natebook page
and rotate them to make the puzzle more challenging — without
warrying that participants might resize the piece,

® o=

1 From the menu bar, click Edit > Select All Locked Nodes. The Lock icon will appear on any
objects you have locked.
2 Click the Lock icon

3 Click Unlock fram the menu. Alternatively, right-click on an object — the Lock icon will appear with
its lnck meny, Click Unlogk from the menu.

Unlock an object by doing (he following:
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Grouping objects

Select two or more objects by holding down your left mouse button and dragging your mouse diagonally so
the objects are surrounded by a selection box. You can also held the Shift key down while you click on each

of the ohjects you wish to group.

Click the drop-down menu from any of the objects and choose Grouping = Group.

Clare
Lk
Copy
Paste:
Delete

Cherk Sesilinm. .

kD
kel
TRl
Chrl+Y
Dz

L ocking

:[H‘i:ﬁlﬁalﬁlﬁrii;l” —

Group  Chello

Flip
Order

- w W oW

Angroup cEhrieE

Infinite Cloner

o T | W e P

Propertiss, ,,

I you wanl {o separate the objects, select the grouped objects again and choose Grouping > Ungroup.

The Ungroup function will alsa break handwritten noles into individual pen strokes.
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Infinite Cloner

@ 4 nfinity sypmbol
_ When you nafl-click oo ar obyect set fo clone
M BT LD ey, e rliraly synbol poeers n the
Irq TrkFike Claner r lop-nghl corner, g & test Box with infinite Cloner

chechod gppears over the viyect,

The Infinite Cloner option in the object drop-down menu allows you to reproduce an object an untimited

number of times, without having to click Clone repeatedly from the drop-down menu. You might use the
Infinite Clener to teach counting or to present math problems.

Setect then presz end drag an objsct to creale
ar dentical object,

Click Infinite Cloner from an object's drop-down menu. Mow, when you click and drag an object sel to

infinitely clone, anather idenlical object is created. You can continue to create clones of the object by
dragqing it until you deselect Infinite Cloner.

To turn off the Infimite Cloner property, nght-click on the object, and click on the Infinite Cloner box. The
check mark will disappear, indicating the Infinite Claner is off,

A money exercise 2 an examole of how the
Infnife Cloner coold be used. The coing on
the pghid are sel fo ilrte Clorer, The
sfudents drag the corec! oong needed (o
pay for the ol

Fil
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Flip objects
Click Flip from an object's drop-down menu to flip an object eilher horizontally or vertically.

"{ Clone Ll
| Zuk Curl
[ Copy Chr+C
| Paste ZErY
| Delets Del
_heclespeting. ..
R 1 Lacking k
araUplne [ |
T LR

"F:?r'&:' Y

Trfinite Cloner

Ll ..
Saund...
i Propetties, .

Order objects
You can change the order in which objects are layered by selecting Order from the drop-down menu,

Toreorder an object one layer at a lime, use the Bring Forward command or the Send Backward
command.

To bring an object directly te the lop layer of the page, use the Bring to Frent command,

Te send an object to the bottom layer of the page. use the Send to Back command.

Four ohiects fayered or
arderen in two different
WEYS
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Adding links to objects

Motebook software training for SMART Board users level 1 leamer workbook

Youcan link an object to a website, another Notebook page, a file on your computer or a file residing in the
Attachments tab. Click Link from an object's drop-down menu, and choose the lype of link you would like
to add to your object from the Insert Link dialog box,

| Hint: I wpe the Wei address, o copy and paste the URL from vour

Page in this File

File on khis F:;jmlput:r

¥

current Atkazhmerts

1 Feamche Liry |

Fe e

Lanch by dicking: (8 Cornarican (L) Ohjact

iE -4

o Tl o | [ 166 )

Nl

Y ou can choase to launch your link by clicking an an icon at the side of the object or by clicking on the object

itself

Link to a Web Page
:- e e Address:
‘Weh Page

browmzer

Hink Type the Weh address, or copy and paste the URL from pour

Once the link is attached to the object, every time you click it your Internet browser will launch and display

the requested page.
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Link to a Page in this File

Tou might use this type of link when presenting a question, For example you could ask a question, then ask
a student to select from a set of ohjects representing potential answers.

The object containing the correct answer could link Lo @ reward screen. The objects containing incarrect
answears could link 1o a page that encourages the student to try again.

Inﬂ- it Liﬁ

Selecl a 'pa'gE"

-~ Firsk Page }f_

Last Page
i Mewt Page
i Prewvious Page
E—l = Page litles
Page in this File 1: Jan 12-11:00 &M
28R 1211129 4M
----- 3 Jan 12-11:06 4
----- 4t Jan 12-11:06 AR

Link to a File on this Computer

Link to a file stored on your computer thal relates to your lesson or presentation. For example, you could
link to 2 Microsofll Word or Excel software file that contains information that qualifies a statement in your
Matebook file.

| ] | [ Browse.. |

Inzert az

(& Copy of file. O Shortcut to file

\

File o I'hi_d';f:nrrq'u_lter
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Link to Current Attachments
Link to a file you have stored in the Attachments lab.

EETTR B R o et i P

InsertLink

AR T R S T Dy e T o T | M S e e

Y

Current Sttachments




Objects in Motebook sofiware

Handwriting recognition

If you have written something with a pen tool in Notebook software, you have the option of having your
handwriting recognized and converted to text. This ool is primarily used when working on the interactive
whiteboard, bul does have eaching applications when developing lessons on the computer.

To convert a handwritten ward to text, click the chjecl drop-down menu and choose your word from the list

. TiP: You can recognize words in different languages. Just select a different defaultlanguage from the [ist.

lh."'; e
Recogrize "girl"
- '\ Reoogrize "girt”
] ' Recogrdze “girl®
f r Recognize “Oir"
| Metognize As 3
|
) Recognize Shaps
X Chane Chrl+D
STt Chrl+E
e
. Paste el
R——— R i Delete Del oo(oo)
a Deutsch
E . .1 ; Gt spetling, - 'Fran;a's
g 1] ' M % itafiaro
i s i ooo
vy :;umg : ooo
O Gt i Mederands
On{ar)
Infinite Cloner English {Lnited Kingdom}
Ltk portuqués (Fartugal)
Sound. . Espaiiol
Properties. ., English

fils]
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Shape recognition

Shape recognilion works in a fashion similar to handwriting recognition, Shapes can also be recognized as
letters and numbers,

If you draw & shape with a pen tool, you can go to the drop-down menu when the shape is
selected and then select Recognize Shape to convert it to a shape. You can also use the
Shapsa Pen from the Motebook software loolbar Lo draw instant shapes.

i,

i o ek ARSI i‘_"

f_"'_' -\ I Raconnize "n"

Hecognize "C"

SRR EEERASEREaE .y

i Retognize "o
: i Recognize "0”
s 1 Recognize As b
Rerogrize Shape
Clore Chrl+D
Cub Cerlx
Copy TR
Paste CErH-Y
Delete Lrezl

| Check Soeling,,

Locking k
eI b
Flip

Drder

Infinite Clomer

Lirek., ..
Anund. .,

Properties...

i
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Typed text
To add typed text as an object to the Motebook file, simply type with & keyboard and press Enter when you
have finished,

The Fonts toolbar appears while you are typing or after you click the lext object icon on the Notebook
software toolbar and click on the work area. Use it to format properties, such as font, size. font style, color,
alignment, rotation, bulleted list, subscript, superscript, mathematical symbals and spell checker options.
You can also quickly change your font by clicking on one of the oplions in the text abject submenu,

Taxt ohigel inon

NP LT PHY R

% TAal= P Aa

Fotation
Buileted st

Text abigct sUbMENy

Fort size  Fond style

Foed fecy Fant colar

Math symbals

Chech speiing

Juusunpi or superscrint

Angriment

E3)

5 3 v[E¥ B0 WESEHEx < Wl
o oo+ JET e o | iIr--..:-_ J‘ $ ABT HBY Mathematical spmbois

i

The Sedov equation (simple linear relationship)
R o EF T p

Rotated text
* lion Bolteted jist E
A
s elephant  .— (LY
= zabra = @
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Check Spelling

prmrme e e RN S el

Clone Cil4 D
ObJ ekt cu Curl+%
Copy ikl
i Paste il
T Delate Del

Click Check Spelling from the drop-down menu to check the spelling of a text ohject,

The Spefling Check dialog box will appear with a list of spelling suggestions if the spelling of the selected
text object is incorrect. Chose the correct spelling of the text object from the suggestions list, and click the
Change button to correct the misspelled word.

SRR P (S AN T et R T £ MBS Ty et o otz w1

'.?-pel'lmg C Imclc

Mok in dickinary

| bjekt Ignare Once ]
lanare Al

P.::Il:l !;4:'- ﬁl:l-naw L

iuggest:ﬁ::ns:

;i St T Change
M T e e e R o | TR
objeck 7 Change Al
!ﬁhjﬁn"l“: .

objected T
i ohjector el R A
ahiark =" |¥|

Dirtionary Lanouiage;

Help
? En.rfﬁ‘:i'u {Arnarcan ) | e E

WWhen Check Spelling is turned on at the toolbar, make sure you tap the space bar al the end of the word,
This action indicates you are finished typing. and Check Spelling can hegin.
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Dbyects in Molgbook software

When you turn the spell checker on, incorrectly spelled words will appear underlined in red as you type.

H\\\‘\\\\\\\\\“\\\\\\\\\\\“\\\\\\\\\\\"\\\\\\\‘N\\\.\\.\\\\\:‘
E‘*ﬂ]—},] el Chech Speiling is of Q

\\\\\\K&‘\\\\\\K\\\\\R\\\\\\‘\‘\\\\\\\\\\\\\\\\\\\\\\\“\

ﬁ'E 5l -@' b
\\\\\\\\\\K\\\\\\\\\"\\&\‘\\\“*h\‘m\\\\\\ 3,\5:»:&%%\?\\\

\“ i
“*Rblﬂplt « Check Spelling is og-———"""_ E:E'

\R\K\H\K\\\K\\\\\\\\\\\\\\\\\‘\“-\\\\\"x\\\\\\\\\‘\\\“\\\\Q

Tospell check all the text objects in your file, click on any one text object to select it, and from the drop-down
menu click Check Spelling ... Notebook software will check the spelling of that word and then ask if you
wish Lo check the rest of the documcnt You are notified when spell check is complete.

Drawing tools

Use the drawing tools — accessible from the Notebook software

loclbar — to create your own objects. ;ﬁ"" éﬁ' ‘af '/' @ ﬁ

Pen and Eraser tools
UIse your mouse to create objects with the Pen, Creative Pen or Shape Pen tools.

7z 2 & Tzl
The sanve alyaect drawr

with thrae differsnt

pens Pan Craative

Pen, Shapa Pan Fart of the
Crenive ool

object erazed by
the Eraser loo!

The Eraser tool erases anything you have created with a pen lool. When you erase part of an object, the
properties of the remaining parts can be changed independently.

B0
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Line tool

Press the Line button on the Notebook software toolbar to draw straight lines  Select any line made with
the Line tool, and drag the end points to stretch it or change the angle. Hold down the Shift key while
pivoting a line, and the line will snap in place every 457

.-’/ Drag 4% o

o s

Shapes tool
Enhance any activity with the Shapes lool on the Notebook software toolbar,

Create a shape

2
BIO0ANSC QO RO

When you click on the Shapes icon, a menu of shapes will appear, Click on the shape you would like to use,
and position your cursar on the page where you would like to create the shape Hold down the left mouse
button and drag your curser until your shape is the desired size. To draw a perfect shape, hold down the
Shift key while drawing your shape

.eIL
E
=

Once a shape is on your Notebook page, itcan be modified the same way you
madify ather objects, using the rotation handle, the resize handle or the
drop-down mendl.

SessEsseEs e

If you click on the Select tool icon and then double-click on the shape, a text
box will appear and you can add a label to your shape.

Fill tool
——— Any shape can be quickly filled with color by tipping the paint can over the shape ubject. The fill
ﬁ. color is the last color chosen from the color palette. To change the color in the paint can, click on
— the shape icon, click on the paint can click on e Pioperlies b and select a color from the colar
palette,

&1



Qjects in Molebook software

Inserting images into Notebook software

Toadd animage to the Notebook file. use the Inser menu o import graphics or clip art from another lncation
an your computer.

Capturing information
The Screen Capture toolbar allows you to capture an image, such as a digital photo from the Internet. to a

Notebook page. To access the Screen Capture toolbar, click the Screen Capture icon (the camera), on the
Notebook software toolbar. Always remember to respect copyright.

Button I How it's used

Hold down the left mouse button, and drag tu outline the rectangular area you want to
capture. Release the lefl mouse button after the area is selected.

| | Click in the window you wanl (o capture. Release the left mouse button after the desired
Lol wmdnw appears gs 8 hatched area,

Press and drag to create a frechand shape armund the area you want to capture. Release the
left mouse buttan after the area is selecled,

{?ﬂ:— ‘ Navigate ta Lhe screen you want to capture, and click the button to capture the entire screen
I
|

g2
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' Review questions: Objects in Notebook software | - : :

1 Label the rotation handle, the resize handle and the drop-down menu on the object below.

'@

o

2 Describe how to move an object from one Notebook page o anather.

3 Why would you add a link to an object that would direct you to another page in your Notebook
file?

4 What is the difference belween Send to Back and Send Backward when ordering objecls?

3 How doyou spell check within a Nolebook, file?
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Review answers: Objects in Notebook software

1 Label the rotation handle, the resize handle and the drop-down menu on the ohject below.

Rokabion hanole ——— 9

- pmaeliaesa -l DOrop-tiowh mean

.M].q_ Hesies handle

2 Describe how lo move an object from one Notebook page to analher,

To move an object, drag ¥ from the work area to a thumbnail in the Page Sorter

3 Why would you add a link to an object that would direct you to another page in your Notebook
file?

You might use this type of link when presenting a question in Nolebook software. For oxample, you
could ask a question, then ask a studen! lo select one of the answers. The objact canlaiming the
correct answer coufd link fo a reward screen, The objects containing an incorrect answer could link
lo a screen with an object that encourages the sludent to try agam.

4 What is the difference between Send to Back and Send Backward when ordering objects?

Send Backwards reorders objects one layar af a time. Send to Back sends an object lo the very |
bottom of & pile of obyacts

5 How do you spell check within a Notebook file?

On the fonls toolbar, select the Chock Spelling fcon. From the Object drop-down menu, select
Check Spelling.
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Hands-on practice: Objects in Notebook software

1 Launch Notebook software by double-clicking on the Notebook software icon on the desktop. Open
a2 new file.

2 Setyour Alignment Guides {(Format » Alignment) Click all aplions to activate them. Click OK. The
thin lines appear that mark the horizontal and vertical centers of the page. Page one is the active
page. Save your file.

3 Creals a lext box that contains your name. From the drop-down menu, click on Infinite Cloner.
From the original text box, drag five copies of your name to various locations on the page. Tum off
the Infinite Cloner by right-clicking on the original, and clicking on the Infinite Claner box to
deselect it.

o

o = Y our MNawe
P e e
| w Infinite Cloner
Y ouy MName
Your MNane
Your WName

Your DMeame

4 Align three of your names by dragging them,
MoTE: With the alignment guides on, grids appear to help you align the chjects vertically and
harizontally.

Wour Namme  Nour SNlame  Nooer D ane




Cijects i Nolebook soffiware

5 Haold down the left mouse button, and drag to seleat all three names. Click on one of the drop-down
menus, and click Greuping > Group The three chiects are now one.

TR Y s B
| Your Nowe! Your Name] Your Nawme Clane ChriHD
| i P Cut el
o Copy Ll
Paske CEr Yy
Dief=te [zl

| Cherk Speling. ..

Locking ¥ B

_(:'Tftruﬁng' __ ____l"I Group Chelis
F|i|:|_- o v I Ungroop Che+R
Order »

Infirdte Cloner

LR

| Zodnd,,,

i Froperties. ..

T T

& Click on the drop-down menu, and select Locking > Lock In Place. The object is now locked and
cannot be moved. If you want to unlock the object, from the Menu bar click Edit > Select All
Locked Nodes. Then click the locked icon and click Unlock. Save your file.

""""""""—__'E_'}

lone Chrl+T

: Your IName  Your Nane Your Nawe ut i
E Copy ChrlHC
| Paste el
b (  Delts Dl

| Chedk Spefing...

T — ol
~Locking [ TR 0 0y, @ Unlock
GrnlIping I-i' '_ L_u:r.!'n;"[h_PJ_aDE__.__ﬁ
Flip ki Aliow Move
Cddor PI Allawy Mave and Raot:

InFinita Clarer

Link. ..
Sound, .
Froperties, ..

ﬁ < Liak foon

Your MNamie  Your Name Your DNawie
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7 Click the Add Page icon to add another page. You are now on the newly created blank page two.
Find a graphic from the Gallery, and drag it to your page. Make the graphic larger by dragging on
the clear circle. Rotate the graphic by dragging on the sclid circle. Save your file.

8 Click on the graphic and from the drog-down menu, click on Copy. Add a page From the menu
bar, ¢lick on Edit > Paste. Click on the graphic. and fram the drop-down menu chck Flip, Up/
Down. Save your file

8 Add another page. Click the Text Box icon, and add four text boxes containing the words help,
bekaus, recleve, and elefant. Click the Select icon, and click on one of the words. From the
drop-down menu, click Check Spelling Correct the spelling of your four words. Save vour file.

\ S

]
srsssseesebessebicnman ey —
H i}

E

i _ Clone ChrD )
clefant hellp bekaus | recieve Cut Crlx
| Copy il
e T =7 Chrky
Delebs Dt
| CheckSpeling..
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10 Click the Add Page icon to add another page. You are now on the newly created page five, Click

™

the Text Box icon, turn on the spell checker by clicking the icon. Add four text boxes containing the
words helln, bekaus, recieve and elefant. To have the spelling checked automatically. you musl tap
the space bar at the end of the word to signify the word is complete If you do not know the correct
spelling, you can right-click on the ward for suggestions. Save your file,

Click the Add Page icon to add another page. You are now on the newly created page six. Click an
the Create Shape icon, and draw four shapes of different sizes. Remember, if you wanl o draw
perfect circles, hold the Shift key down while you are drawing. Click the Properties tab. Fill each
circle with a different color. Practice ordering your objects by moving them so they overlap and then
bringing objects to the front or sending objects lo the back, Save your file.

12 Share your results with your colleagues. Close Notebook softwareby clicking File > Exit.

34
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Where do | start when creating a
lesson activity for the SMART Board
interactive whiteboard?

Notebook software tools include functions that help you use the interactive whiteboard more effective! v and
aflow vou to create engaging, interactive and dynamic classroom lesson activities.

a4
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Creating interactive lesson activities

This section is intended to act as a reference for the best practices for creating and

presenting lesson activities using Notebook software T ~ ,\]
You are already familiar with the basics of Notebook software, such as how to write | % ﬁgjﬁ i
in the work area, how to add new pages to your Nolebook file, how to navigate from Iu,ﬂ"w ’iﬂ.r"

one page to another and how to select and move objects on a Motebook page. .

To review the basics of working with a SMART Board interactive whiteboard and
Motebaok seftware, visit SMART's training center at

wwnn smaritech.comitrainingcenter

Refore reading the remainder of this workbook, make sure you have Lhe |atest version of Notebook software
installed on your computer from wwew smarttech comGsupportsottware,

Review of design basics

Lesson activities need to be designed for both content and presentation. The SMART Board interactive
whiteboard is a visual and an interactive medium. Knowing a little about design and the best practices on
how to integrate interactivity using Notebook software will help you create |esson activities that meet
curriculum learning objectives and engage students. Creating content in Notebook software wilh (he
knowledge it will need to be presented in a classroom setting will ensure your lesson goes smoothly,

(_ Content K resentatioi)

Onee you have delermined what content you will be teaching, create a title page and write your teacher's
notes at the beginning of your lesson activity. Title pages and teacher's notes focus learning objectives and
provide important information lo any other teachers who use the lesson activity. You can see examples of
how other teachers have crealed these items by downloading any lesson activily from the education
solutions website wwaw . education smartech. comisleden-US/Ed+ Resource.

Setting up your page
Once you have an idea for a Notebook software lesson activity, you will need to start designing your page
Chne of the first things you will wanl Lo do is decide on 3 background colar,

When choosing a color, keep in mind that very bright or inlense colors can be d istracting and draw attention
trom the page content to the background A bright yellow might seem like a fun choice, but it may also
distract from other elements on yaur page. Reserve the most vibrant colors for individual ohjects on your
Molebook page to which you want to draw student attention.

a0
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Select a background color by selecting Format > Background from the Motebook software menu. A color
palette will launch from which you can choose the background color of your Nolebook page.

Draw Senteo |:|':£||'.| TSR [
m — HEEEN

o s _ EEE
pa T NN EE R
:~a!alc I T ' ,.I ,'E mLEEN
el PR G | T

Jet Trem Properties,, 4 | PR =l _|D

SEE Firtin e Transnatar HoFl dl m

Lcling 3 ?

Ml b e

Buclgroud, ., -

Thermas k
- Aligrraent, .

Working with fonts in Notebook software

Mext, you should choose the fonts you will want to use for the remainder of your lesson activity. One way
to set your font is to select your text and use the functions available from the Fonis toclbar. The Fonts

leolbar appears whenever you are typing on the Notebook page or atter you double-press a text object.

Font sire Fanaf eoioe Spall chack
Facs ) T A v (B s UNEE S |INE L
? :
Fonk style Alignment, rofate, hullels, subscopt

superscript and special characlars

If possible, try using only one fonl throughoul your lesson activity. Too many fonts can be distracting to the
eye and draw attention away from important points.

General guidelines for choosing fonts for your Notebook software lesson activity include the following:

» Titles should be at least 28 point and a bold lype face
« Text used for sentences and paragraphs should be at least 22 point and in a regular lype face

« Make sure the font color you choose is easy to read and see against the background color you
have chosen
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Math and science symbols

Math and science teachers will find the math and science symbols paricularly useful for writing equations
or formulas. When you click on the Math and Science icon, a series of submenus are revealed. Clicking on

each submenu reveals another series of choices. Click on your choice to insert that symbol into your text
b,

= = Hﬁ::

1l s —

<zx o+ JET  o¥V3 Enc p;: ABI DiE‘f.

Average angular velocity = Angular displacement / time interval
w =A0 | Ay
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Adding interactivity

One of the benefits of Notebook softwars is the abilily to modily objects on the page. This section will focus
on some of the different ways you can engage your students by designing interactive lesson plans.

Reveal

One ofthe quickest ways to add interactivity to a lesson activity is o hide the answer to a question behind

an object on the Notebook page. The following infermation will provide four different methods that you can
use to create reveal activities that can easily be integrated into any curriculum,

Move and reveal
One way to create a reveal activily is lo hide an answer behind another object,

1 Type vour guestion and answer
2 Draw a rectangle, and fill it with color to hide the answer

2 Doubde-click the shape for the ability to add text to it — ensure your text is a different color than the
rectangle

4 Type Mave the hax fo reveal the answer — you are adding instructions to the shape so students, other
faculty members ar a substitute teacher will be able to work with the file. \Without the instructions,
someone might assume they are supposed to write the answer cver the shape instead of moving it to
reveal the answer,

TiP: It is a good practice to select Order > Bring to Front from the drop-down menu on any object you will
be using to cover an answer. This action will ensure your students don't see the answer before it is time
 for it to be revealed

5 Move the shape to reveal the answer

What is the national animal of England?  What is (he national animal of England?

Move the bc}:.-t to . R thvadion Maove the box to
revezl the answer. reveal the answer.
Befora After
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Erase and reveal .
Another way to reveal information is with the Eraser tool. T 4

1 Type your question and answer. Use a pen to cover the answer with digital ink.

2 Click on a pen tool. Choose an ink color the same color as the page background. For example, if the
page backagraund is white, then the digital ink should also be white.

3 Click on the Eraser tool, and erase the digital ink covering the answer, The Eraser tool will anly erase

objects created with digital ink. Anything lyped with your keyboard cannot be erased with the Eraser
toal.

TiP: You may want to add instructions to let the class or other teachers know that all they need to do is
use the eraser. '

Complete the number sequence Complete the number saquence
Use the eraser to reveal the next Use the eraser to reveal the nest
number in the sequence. number in the sequence.
13,57, 138, 1.9

Bafors Afiar

Order and reveal
Ancther way to reveal information is by ordering objects.

1 Create an object
2 Create a second. larger solid object
3 Move the larger object over the smaller objecl, which will be hidden

4 When it is time to reveal the smaller object. vou can either move the larger olbject aside or change the
arder of the |larger object to Send to Back

TIPZ You may want to add instructions to let the class or other teachers know that all they need fo do is
move the object.

What is 4 + 4?2  What is 4 + 4?

Fellow sirele covenng Yeliow circle Sent to Back
redd ciaht
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Screen Shade and reveal
A fourth way you can reveal information is with the Screen Shade tonl,

1 Type vour question and answer
2 Click the Sereen Shade bullon on the Notebook software toolbar
3 Drag the Screen Shade so only the answer to your guestion 15 covered

4 When you are ready, drag the Screen Shade so it no longer covers the answer. This action is similar
to using paper o cover answers that would be displayed through an overhead projector

TIP: When you open a No;ebnuk file, the Scresn Shade w'ilghe cﬂvenng the same areait was hir:}lng, and
you will be able to start discussing. the content in your file from exact[;r where you left off. .

Agricultural Woes - Timeline Agricultural Woes - Timeline
al i e . A e 19&3—-«1« 1 T L P A s B e - ik b e P e o
T
19&1. i e =
Refore - After

What is the capital
of France?

What is the capital
of France?
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Identify and label
Drag and drop

Drag and drop activities are an excellenl way to determine if your class has achieved recognilion about
specific learning objectives.

Tocreate a drag and drop labeling aclivity, add the object you want labeled to the work area. The object can
come from the Notebook software Gallery, the My Content area or it might be a graphic you imported using
the Insert menu, Use the object drop-down menu te lock in place the object that will be labeled. This action
ensures the ehject won't be accidentally moved during the lesson activity.

Next, make the labels for your diagram and line them up at the bottom of the Nolebook page. Then you can
ask members of the class to drag the labels to the appropriale area of the graphic.

Appendin

Tongus
Pancreas

Teeth
Gzl Bladde

Salivany Glond
Diuodemmmm

Epigleostis
Smzll Intestine

Large [nrastne

Rectum  Escphagus

Liver
Stomach

Coammon Bile Duct

Drag the labals fo the
apprapnate part of the
diggram.
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You may want to add a link to an chject, such as the diagram of the digestive system above, to another
Motebook page with an answer key. This page will help anyone you share the file with find the corract

AnSWers.
Drag and drop activities can also be used for text-based lessons. For example, you might drag events to

specific dates on & timeling, defing a series of wards o malah information,

Tchaikovsky

- Russia : F_raﬁée; s
Debussy MR A SRR AT B
Beethoven ltaly '._Gérﬂléﬁ}f-
Chopin LlE R SRR
sy Poland Austia
Vivaldi : :

Crag the name of the famous compaser to the nountry of his bath,

Infinite Cloner
The Infinite Cloner allows you to reproduce an object an unlimited

number of fimes, withaul having to select Clone repeatedly from the 5
drop-down menu, The Infinite Cloner also helps keep your Notebook /? 5
file's size smaller than if you were t¢ copy and pasle the same g eal. ¥
informatian, making the file easier to share with your colleagues. e Tl
oI\ 5
To sel an objecl as an Infinite Cloner, complete the following steps: % 4
e ™
1 Click on an object 5 H

2 Click on the object drop-down menu

: b Fress and drag o creale
3 Click Infinite Cloner an identical ahject

4 Click on the object, then drag to create an identical object

Using the same object for multiple answers
One advantage of the Infinite Clener feature is the ability to creale a drag and drop activity without diluting
the pocl of available opticns each time a guestion is answered correctly

243 10-5= | 12435 10-5:5

B 124155 | 5x6= 30 12415z 27
| .-
|| PR

9/3:= 7x%3= | 1953:3 -?fof*Ei

— —_— e

¢~ 0123456789 H3012345678¢9

Feteach number on the number Use the same numbar multinle
live ag an hfinite Clanar times (0 answer e gueshions,
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Creating nteractive lesson activities

==3=F _JJI

Younger stodents " in the
Blanks" with infinitely clonod

ricdes, or on blank music

sheets, Compose so0us for
e thieir clazsmales fo play

==
G

Element

Symbol

Classification

Oxygen
Hydrogen
Helium
Lithium
Boron
Beryllium
Neon
Sodium
Tin

Gold
Silver
Uranium
Chlorine
Carbon

28

Metal
Non-metal
Noble Gas

Lirag and drop e spinbel end classification o tha
cormesronaing clement — Metal, Non-Ndetal and Nobla
Sas are infinlte dlones so they may be reused,
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Keeping information in context

Another benefil of the Infinite Cloner feature is that it makes it easy to keep information in context This
feature 15 especially usetul for text-based lessons.

How many different words can you make from this word?

shakespeare

rape 4,
zphase 2
+.Shake 6.

Sl each lether of 8 word &8 &0 Infinite Cloner, Drag the lettar ta a diffarent
araa of pour pags fo create anagrams, The onginal vord! vall rermgin m place,
You gy wart o zet g mer fo make the lessor mora challenging An
Interachve timer is availale from the Gallory Colleshons,

Magic Pen

i "

The Magic Pen icon from the Notebook software toolbar allows you to highlight parts of your
« Netebook page in a way similar o the Spotlight tool on the SMART Boeard interactive whiteboard

Magic Pen Spotlight
Click on the Magic Pan icon on the Notebook toalbar (o aclivate it

Crraw a circular shape on the part of the work area you wish to highlight.

When you move your cursor over the magic shape, it turns into a double-ended arrow. This arrow allows
you to make the highlighted area larger or smaller,

- Mona Lisa
Leonards da Viner
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Crealing interactiva lesson activities

Magic Pen zoom

When you use the Magic Pen and draw a rectangle around an area on your Notebook page, it will allow all
to zoom into that area.

Chyisr BO%

L

AL - EGE

2 A0

W 0

When your cursor approaches the magic shape: it tuins into & hand, This hand allows you to move the magic

shape te zoom or highlight a different selection, The double-ended arrow allows you to resize the zoom or
highlight area,

To close a magic shape and return your work area to normal, click on the X in the box,

When you wnite or draw with the Magic Pen, the ink disappears in about 10 seconds. This feature is an
excellent way to keep your work area uncluttered. Itis also a fine way to offer sequential problem solving
clues lo a class working on @ SMART Board activity. You can use the Magic Pen to warm up the class by
playing timed Brain Gym type exercises

When the Spotlight or the Magic Pen are active. teachers can anly write on or activate components in the
spatlighted area,
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Review questions: Designing interactive lesson activities T

1 What are some ways you can reveal answers to the group?

2 How would you use the Magic Pen®?

3 How do you access the additional math and science symbals?

4 How would you use the Infinite Cloner?

5 Why is font selection important in creating a Molebook file?
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Crealing inleraclve lesson aclivities

Review answers: Designing interactive lesson activities

102

1

What are some ways you can reveal answers to the group?

Move and reveal
Erase and reveal
Orger and reveal
Screen Shade and reveal

Why would you use the Magic Pen?

Bring allention to one area in Notebook saffware

How do you access the additional math and science symbols?
Couble-click on typed text and select the math and science symbols icon

How would you use the Infinite Cloner?

To reproduce an object an unlimited number of times, for instance, in counting activities, graphing
exercises, spefling and word games

Why is font selection important in creating a Notebook tile?
Allows for less distraction; keeps the file consistent allows for everyone in the room to see the text




Hands-on practice: Designing interactive lesson activities

Preparing your lesson

Motebook sofllwaie barnng lor SMART Board users [gvel 1 learmer workhook

You will prepare a geography lesson activity that asks students to match Morth American countries o their
flags. You can use the concepts outlined in this hands-on praclice to prepare and deliver lessons in other

subject areas.

1 Open a blank Malebook file

2 Click the Gallery tab 1o search or browse collections of SMART s custom pages, clip art, Flash
animations and video files. For this example, you search for flags of North America.

TiP: Deselect the Auto-hide check box to keep the Side Tahb visible. This action will provide you with easy
access to the Page Sorter and Gallery tabs as you prepare and deliver your lesson.

3 Type the keyword flags

4 Click the Search icon, which is the
large rmagnifying glass, to initiate your
search.

5 Motebook software displays your
search result(s) as a thumbnail image
malching your search crileria. In this
example, a folder named Flags will
aAppear

& Double-click the folder thumbnail to
view its contents

7 Scroll through the Gallery collection to
find flags for the United States
Mexico and Canada. Drag each flag
to the work area of your Motebock file.
You can double-click the flag's
thumbnail image to guickly add it to
your work arca.

I8 T h
N |Flags P
| ¥ 'I'l'::l_';|||'|u|l..|l=|5.; |
| E Transportation

ER: ,:% Special Needs

i : '::. &L Sporls -I:u!I.I H.I.'l;;rs;\lﬂ.iuu

| i Lesson Activily Toolkit 1.0

| i = allery Sampler =
i & Search Results for flags @ = I
e ) B
Zearch Results for flags C:J

1 jtemn E?; :
=] ]
|« Related Folders (1) |

Click ke inifiate
zearch

Double-click
fhe foider
thaembrad to
i i
Cotenis.
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Craating interactive lesson activites

8 Resize each flag by diagonally dragging the resize handle, Fnsure the flags are approximately the
same size,

®

Orag ar objoct's resee
i handia to chonge s

£y : ;
-.[: M— dimensions,

9 Align the flags horizantally
10 Write the name of each country in a different color

11 Click Unifed States, for example, and choose the appropriate typed text from the object's drap-down
menu. Converl Mexico and Canada from handwritten 1o typed text also,

2
i e = =1 ;
| T e
] Rreiog iz "unkec Statns®
Keoognize A5 3
- - th
: a E— 5 Renrrrine Shape
Chag CHn
n \ e Cut Chil=X
| Conpry Chil=iC
e e R e e | P S
Daely Frl

12 Click Clone from the abject’s drop-down menu to make a copy of the name of each country. There
should be two country names for each flag.

2]

e (o

1 ™ Cit hrHe

} d 1: LT L 13 g

!I Il]. e a e S Farie b

; Lkt Ll

: | Check Sprkng...

e

Laching 3
G R [
Flu 3
fndar ]

Infintr Clerer

13 Organize the names of each country so that one set of country names is placed in a vertical line on
your work arca. Drag the other country names over their corresponding flags

offl I

A

Mexico

(Canada
United States
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14 Click the United States flag, for example, and choose Order = Bring to Front fram the abject's
drop-down menu to cover the name United Stafes Complete this task for the Mexican and Canadian
flags.

fuh

Ciihed

[AT[R N

Chiey
[ 1 =

i # ==
| I
i -
¥ ¥
it Mg e T st il | ;
| wadmdak kbl

I Y PR R
Sand batsa] ChbFrin |

The Linited Stales flzg s positionoed et e typed lext The Urnled Sieles leg is now
poshoned w fronl of the typed fext.

15 Click File > Save to save your Motebook file. Give vour Notebook file a name, and choose the
location where you want to save i,

Using your lesson in the classroom
After opening your saved Notebook file on the SMART Board interactive whiteboard, ask your students to

drag the name of each country underneath its corresponding flag. Once the exercise is compleled, remove
the flags {o reveal the correct answers,

TIP: Select a fun setting from the Creative pen menu to add check marks to correct answers.

You can add as many pages to your Noteboaok file as you need to create additional lesson activities, such
as labeling continents or identifying capital cities on regional maps,

Preparing your lesson: Advanced features
The: My Content area is a Gallery collection reserved specifically for objects and lessons you have importad,
captured or created, such as the lesson you just finished preparing. It's also a good place to store objects
and lzssons you use frequently or wanl Lo share with your colleagues.

1 Open your geography lesson

2 Click on the Gallery tab. By default, the My Content folder is selected

3 Click the My Content drop-dewn menu and choose New Folder
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Creating interactve lesson achvilies

4 Launch the Gn-Screen Keyboard and type Country Lesson. You have now created an area where you

can store all objects related to your geography lessan,

e seamnamere [v] £ Foll G lmeseaniomree ]2 2 [
LI = L)
'ﬁ' SMART Learning Marketplace s i | @ SMART Learning Marketplace ;
o ki s it M) (= _i 5
| | — B =5 My Cont
B My Centent | | | & ;‘# My Content _
(3 online Esse _ 1 s Country Lesson EJ E
B Themes Copy gio (% online Essentials for Educators ' = ||
T Essentials fo|  paste I 4 Themes
& Lessom Activ]  [ajaes ' ® Essentials for Educators ~
& {7 Gallery Sam| |, o == £ Lesson Activity Toolkit 1.0 C.’ﬁ"
E _}’ Search R&an — i 9 Gallery Sampler
B L A & search Results for flags
e Eitart Al L My Conkert, [T : %
y Conten T ; . Solntry Lessan el |
y Feport a6 Collect i
0 Hervis wport ac Collection File 0 it .J_ﬁ |
Fropethias b
T iz A
Crogle g new folder, Yo ew folder catled Country Lesson appears undar

My Content

5 Drag each flag and country name into your new Gallery collection. Your new Gallery collection now

contains nine individual Gallery items — one flag and two names for each country,

T I —— e o TR e T = ..q.....ﬁq — QE
El LT P ARAIR
B e eieies I BT
_ﬁ AMANT Laarming Masketplace o] ._|’.__ | I
= Fol My Cortert |
E;*‘ Cuuntry Lsrsen !3‘!‘: =
. (% online Ersennals far Coocstars | = || B
B 0k
MCKICD &5 E-.f:::l; lur Sdusalo: s |~ ¥ |
= Lessnn Activies Tanlzit |0 é&' I
- & = Gellary Sampler _.'\3" e |l
L anada s ot i) |51 ;
Sy f EEA |
ﬁ- Couray Lesson = I = |
UnitédsSgates ||~ ] |
o
>~ B

€ Select the Page Sorter lab. Insert a blank Notebook page by clicking the Add Blank Page

icon on the Motebook software toolbar,

7 From the Shapes drop-down menu on the Notebook software toolbar, select the square.
Fosilion your cursor on the left side of your work area and draw a large rectangle.

8 Click the Select tool from the Nolebook software toolbar. Fill the rectangle with color by

selecting the rectangle, then choosing Properties from the ohject's drop-down menu.
Tir: Alternately, you could change the rectangle’s properties by using the Properties tab.
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9 Taothe right of the reclangle, write or type Languages: and below this write or type English, Spanish,
English and French

Languages;
English
i o | Spanish

= e English and French

10 Press the page thumbnail's drop-down menu in the Page Sorter tab, Select Add Page to Gallery to
place the entire Notebook page into the My Content area of the Gallery Cellections. This aclion gives
you quick and easy access to Notebook pages [or lesson planning and delivery.

wal Alekderd |1
i 1_HI-I = | e || -
1 - i L My Content —
1 [-_.-"J { 10 itermis |j‘ jf
| i b |
Jan 13556 PM = B e |
| é:»’) [ ¥ 1:F'Iu:ﬂ:!_lres. and Backgrounds (9} |
| [s—— a i'!'edl:uj:ebuu:uk-Fjles and Pages (1) !
- — ] [ Lo —_— - E . : e - =
e T [ [
Clear Mrage kL t EEA | l
| J ——

Tnsert Blank Page CrlbM

Clore Page CLel D | ,/"7 ’ i

Fename Page | L
A Language & |
Sereen Shade | i % Exercise & ¢

Shio Al Liriks filt el ]

o

-1 - - - - - e - I
|| Add Page to Gallery e !

TiP: Name your new Notebook page Language Exercise so you can arganize your Gallery items into
meaningful groups. : ;

11 Drag the Mexican flag from the My Content area to the top-left corner of the rectangle you created in
step seven. Then drag the word Wexico to sit directly below the flag.
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b ._E_{lg_lish and French | | i o]
(=0}
oy L. e = I-: Caraca el Huiiza ;I
Muniy Mumuon |

| =T R
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Creating imleractive lesson activities

12 Drag the Language Exercise page you created in step 10 to the work area of your Notebook file. This
action will automatically insert a new Notebook page directly after the active Notebook page

13 Repeat steps 11 and 12 using the Canadian and United States flags and associated text

14 Press File > Save to save vour Notebook file

TIP: Share your geography lesson with other colleagues using the SMART Board interactive whiteboard
in the classroom. Select Export as Collection File from the My Content drop-down menu to distribute
your electronic file.

Using your lesson in the classroom

Invite your students up to the SMART Board inleractive whiteboard to draw an arrow from the language text

to the corresponding flag using the Line tool or a pen tool from the pen tray You can hide the correct
answers behind the rectangle or flags.

O ™

- e— - ———pr
Fie [ Wwsd (reed HEvR! Dren Help

MDEQRTIS WEBL S8 76 AP s
R S i [P

bt ISR e,

S English
- _ Spanish

Mexico / English and French
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Why and when would | use an

interactive whiteboard in my
classroom?

Interactive whitehoards and their collaborative Jearning soffware have many strengths in the classroom.
Thiz section explains whal an interactive whiteboard is and what its advantages are over fraditional and
other digifal mediums. General usage Hps are also outlined.
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Explore the possibilibes

Understanding the interactive whiteboard

Each brand of interactive whiteboard operates a little differenlly but they all have some caore similarities All
interactive whiteboards get their information from & computer and their image from seme type of projection
system. either rear or front projection. Each interactive whiteboard has some means of recording where you
are pressing on lhe sereen. Some interactive whiteboards register the pressure of your touch on the screen
Other interactive whiteboards use electromagnetic technology that is housed in special pens and read by
the board. Several others use a camera system that sees where your finger or stylus is on the board.

Whichever way the interactive whiteboard senses your inpul, this information is fed back to the compuler,
which uses that input to navigate through digital information the same way that clicking your mouse does.

Essentially, anything you would do with your mouse on a computer screen. you do with your finger or a
special pen on an interactive whiteboard,

T
B e o - P, L P S
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An interactive whiteboard can do anything a computer can do

Because an interactive whiteboard is just another way of seeing and controlling what is on your computer,
you can do anything on it that you can do on the computer it is attached to. The same software can be
loaded, used and saved, A wireless keyboard can be attached so that you can type You can also navigate
the Internet and play video, sound and other multimedia

Interactive whiteboards add some functionality to your computer

Interactive whiteboards also add some extra functionality to your computer, or rather Lhe collahorative
learning software that comas with your interactive whiteboard adds functionahity. All interactive whiteboards
are set up to make il easy o wiile or take notes on top of your other applications or in specialized
note-taking software that may be provided with your interactive whiteboard. Many interactive whiteboards
recognize the text you wrile and lurn it into typed text. Some interactive whiteboard providers incorporale
soflware that allows you to input handwritten text or drawings inte your favorite software applications such
25 Microscft Word or Excel spreadshest software

Integrate with other technology

Many users don't realize that you can also seamlessly use additional technology such as DVD players,
document cameras and video cameras with some interactive whiteboards, much as you would with a
television.

What you can do depends on the interactive whiteboard provider

One of the biggest factors separating the various brands of interactive whiteboards is the quality of the
software and teaching resources Lhey provide. In discussions pertaining to interactive whiteboard use in the
classroom, we will be assuming the use of high-quality collaborative learming software that 1s designed to
support the easy creation of interactive whileboard lessons. As 3 result, there may be some sluggestions
mentioned in this module that your brand of interactive whiteboard is not able to accomplish or accomplish
easily.
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Explore the possibilities

The interactive whiteboard’s role in the classroom

An interactive whiteboard with collaborative learning software has a number of major strengths that make it
a wonderful tool in the classroom.

Use an interactive whiteboard for the following: Some advantages of doing these tasks on an
interactive whiteboard are the following:

+ Whole-class teaching = Teachers can be more flexible with their

presentation of material
« Demonstrating an activity before students begin

independent work + Students can be involved in active full-class
activities
= Infroducing and generating exciterment about a new
topic = Images and multimedia can be casily
imtegrated
= Writing notes that can be saved and printed or
posted to a class website = Paslwork can be easily pulled up and revisited
+ ldea generation and concept-mapping « Lessons and notes can be saved and printed

« Reviewing and revising at the end of the day ar unil | = ILis easy for all students to see

+ Showing a video and annotating on top of it * Teachers can do more with their full-class
lessons using less prep time

Some teachers also use the interactive whiteboard and collaborative learning software for the following:
+ Classroom management (taking attendance, timing breaks)
= Displaying assignment information lor sludents to reference as they work at their desks
Interactive whiteboards are great tools for the clasaroom, but like any other tool they should be used only
when it is effective to do so. There iz no nesd and probably no advantage in asking students to spend all
day in fronl of the: interactive whiteboard. While the interactive whiteboard is an excellent tool for many

classroom activities, it is best to leverage whole-class interactive whileboard use with other activities, just
as you would in a classroom wilhout an interactive whiteboard.
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Best content for exploration on the interactive whiteboard

Any type of curiculum content for any subject can be explored on an interactive whileboard, but some
content makes more sensea than others. Below are some general guidelines for getting started,

| An interactive whiteboard with collaborative
learning software Is an excellent choice for the
following:

An interactive whiteboard makes a poor
substitute for the following:

» Showing a video — An interactive whiteboard is

better than a television because you can take
screen shots of a video and build lessons around it
You can alse pause and annotate over a video to
highlight infermation.

Conlent that is highly visual and difficult to explain
without images

Cantent that is too dangerous. inaccessible or hard
to see in real life

Witing lecture notes that you can save and print
later This ability also saves teachers from having to
wait for students (o finish copying so they can erase
the board and keep wnting.

Lessons where objects need to be manipulated such
as a classification exercise or coin-counting
exercise, but itwould be too time-consuming or hard
for the whole class to see with real objecis.

Content that is abstract bul that you want to male
more concrete through use of simulations or Flash
animaled learning objects

» Interacting with schools or guest speakers in another
part of the world

+ Real science experimants

¢ |Live visits from guest speakers
» Field trips to accessible destinations

« At using real matenals. However, it is
excellent for art history and art theory.

+ Music using real insliuments, butitis excellent
for theory and history,

o |Individual use of manipulatives
» Physical activity such as recess

+ Leamning to print with a pen and paper
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How do | design a lesson that
enables effective teaching using
an interactive whiteboard?

This section explores the relalionship between traditional instrucfional design praclices and engaging,
effective lesson activities designed for the interactive whifehoard
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Lesson design

Instructional design basics

Planning any lesson activity Involves thinking about what cantent you want students to explore and how to
present that content in & way that is meaningful. engaging and effectively achisves student learning
outcomes. Teday's classreoms are diverse and challenging. Good teachers take many factors into
consideralion when designing their lessons. It is the consideration of these factors in lesson developrnent
that we reter to when we use the term instructional design.

What's different about instructional design for interactive whiteboards?

The interactive whiteboard i1s a digital, visual medium that shares many qualities with a screen and digital
projector. Fart of what makes instructional design for interactive whiteboards different fram traditional
instructional design, or lesson planning, Is dealing with this highly visual, digital medium — avoiding Death
by PowerPoint, as they say,

What sets an inleractive whiteboard apart from a screen and digital projector however, is its capacity for
interactivity. A large part of this reference guide deals with understanding and taking full advantage of the
unigue strengths offered by interactive whiteboarding technology,

This section is inlended to be a reflection of the best practices you already know and incorporate into your
lesson development, through the lens of interactive whileboard use. Knowing a little about design for a
visual medium, and some best practices for how to integrate the strengths of an interactive whileboard into
your lessons, will help you create engaging, meaningtul lesson activities that meet curriculum leaming
obijectives and save you tme as a teacher.

The following principtes of good lesson design, as they apply to interactive whiteboard lessons, will be
discussed,

» Convey content clearly

= Targel student age and ability

= Enable active student participation

+ Cater to multiple learming styles

= Consider special nesds

= Involve the entire class

« Seaffold students into other activities
= Encourage further inquiry

« [Cnable assessment of lcaming objectives

= Allow review and reflection
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Convey content clearly

Conveying content clearly becomes a highly visual issue when presenting a lesson on an interactive
whiteboard. To convey information clearly you'll want to remove distractions, make sure textis easy to read
and ensure lesson sclivilies are clearly explained, The following section will give you a place to start with
designing clear, attractive lessons,

Give your lesson a title page

Onece you have delermined what content will be taught in this lesson, create a title page and include a
section of teachers notes at the beginning of your lessan activity. Title pages and teacher's notes focus
learning ohjectives and provide important infermation 1o a substitute teacher or any other teachers that
might share the lesson activity,

Consider your background color

When choosing a background color. keep in mind thal very bright or intense colors can be distracting and
draw allention from the page content, A bright yellow might seem like a fun cheice, but it may also distract
from other elements on your page, Reserve the most vibrant colors for the individual objects on your
interactive whiteboard page to which you want to draw student atiention

Although a white background is typically the default option, you may wish to consider an off-white or pastel
color as a background for your lesson. A bright white reflects a lot of glare and can be hard on some
students’ eyes.

Select fonts appropriately

When you are choosing a font, you are choosing how your text will appear on the interactive whiteboard
Each font has a personality, and some are easier to read than clhers. For example, Times New Roman,
Comic Sans and Arial all leok very different,

F F -

Lienes Mew Homan Lormic Sans Ariafl

If possible, fry using only one font throughout your lesson activity. Too many fonts can be distracting to the
eye and draw attention away from important points.

Using too many fonts can make your
lesson activity difficult to read.
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Use fonts that are installed on your interactive whiteboard's computer
Your computer comes with a small number of default fonts. Installing certain programs adds more fonts ta
that list. New fonts can alse be chosen and downloaded from websites that specialize in providing or selling

unusual fonts. Some fonts are specific to either Macintosh or Windows operating system plalforms, while
others can be used on both,

A5 aresult, some fonts are comman tw just about any computer, for instance Aral and Times New Roman,
while others might be on your computer but nowhere else. You will need (o use caution when using unusual,
non-standard fonts in your lesson, otherwise you may experience a frustrating message telling you thal the
font you used on the amazing lesson you created at home cannot be found This occurs because font
information is stored on each computer and only referenced, not stored, by the interactive whiteboard
software you use. To avoid this complicalion, use only common tonts in your lesson development. If you find
an unusual fonl that you can't live without, install it on both your home computer, if you create lessons at
home, and on the classroom computer that the interactive whiteboard will be using.

Never sacrifice clarity for style

Consider the size and color of text you will be using throughout your lesson activity, Always think about the
student at the back of the class. It may be hard to tell whether your text is big enough or clear enough when
you're crealing it at your personal computer. A projector will enlarge your text but chances are good that
your students won't be as close to the interactive whiteboard as you are to your persenal compuler soreen.
stand back from your computer moniler lo gauge clarty or test-drive your lesson an an interactive
whiteboard. Ifin doubl, always choose clanty over style. Once you have decided what your text will look like,
make sure you keep it consistent to give your lesson a nice flow from one page to another.

General guidelines for choosing fonts for your interactive whiteboard lesson activity include the fallowing:
+ Titles should be al least 28 point 2nd a bold type face

- Text used for senfences and paragraphs should be the same font as the header, 22 point and in
a regutar type face

* Make sure the font color you choose is easy to read and see against the background color you
have chosen

Fonts life #his may look nice, but considesr where HoU use them, Titfes
and fun gares are fine, but do you wont fo convey an imporsant fact in
such a distraciing, bard fo read fonif

Use an age-appropriate font

Reading different types of print 1s actually a skill that develops over time. Primary grade children who are
justlearning to read and write may find it easier lo read a font where the letters more closely resemble those
they are being taught to prinl. The lower case a of typed print tends to be the mnsl confusing for very young
children Seril fonts such as Times New Roman are also confusing for children because the letters are
shaped differently from those they printin the classroom. Teachers of very young children may find il helphul
to find the perfect font by downloading one that closely resembles handprinting from one of the many
websiles that offer fonts for free or for a charge. However, be sure to install this font on both your home
computer, if you create lessons at home, and on the classroom computer that the interactive whiteboard will
be using to avoid missing font errors,
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Don’t be afraid to start a new page

One of the nice things about interactive whiteboard lessons i that you don't have to feel guilty abaut using
3 lot of pages to present your informalion. For maximum clarty, keep your lesson design to one ides per
Page. As sooh as the page starts to il up with content, break the information into two simpler and easier to
read pages.

Be wary of overly text-heavy pages

Pages that are crammed full of text are difficult to read and, let's face it boring to look al Limit text to a
maximum of five bullet points per page, or three for young children, and be as concise as possible with your
lext. Not every word that you will be speaking about needs o be on the page. |f possible, lighten your lessan
up with some images or interactive elements. If the type of content you are dealing with i= not conducive 1o
images, or if you'd rather nat spend time on them, consider using color to separate and define your page,
The image included in the following section is an example of lesson layout using graphic elements rathar
than images,

Consider developing consistent themes

Consistent layout of your lesson from page-lo-page lets the viewer know where o look for information.
Additionally. the randorn or unattractive placement of nbjects distracts many viewers fram focusing on your
Important content. You don't have to be a graphic designer to make a lesson that is clear and easy on lhe
eyes. Here are some tips

Tithes and subtitias hels to
dafine fhe fope. T —

If you choose & vse nowgabon
buittong, keap their locahon consisfent
from page fo-page,

' You may wish to use separate zones on your page
The same easy-o-raad font is used _wthal are obvious fo the user, such as instuctions.
throughout Font size 13 large and-—" »
confrasts well wil background anlars, |

Lapaul is sumple and attractive,

Cilor 1z used sparinoly and effecfivaly.
Color separates and draws affention fo |
slements without baing distracting, The
seine color scheme Js used roughoot

Activily boxes

Simpie symbols instantly jadicote
e lype of information 3 vicwer cen————
expoc! (o see thers |

Consider using a color coded theme for different subjects so
that sludents know right away that "this is math time”.

When you have developed one page that you are happy with, copy or clone that page and use it as a basis
for the other lesson pages This will save you time by preventing you from arranging things on each pEge.
It will also keep your layout from appearing as if it jurps around when you switch from page-lo-page,
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Make links obvious and relevant

Inserting a link inte your lesson gives the computer the informalion it needs to bring up another document,
a different page in your lesson, a video or a websile on the Internet. Some interactive whiteboard software
offers you the option of making an object into a link or displaying the link as an additional icon that you can
touch to activate. Setting up your link so that it is activated when you touch an object is useful for making
navigation buttons or creating an activity where a reward screen opens if the correct object is touched It is
also useful to set your actual text as a link, rather than a separate icon near the text, if you want the link to
more closely resemble text links that appear on webpages.

Whichever slyle of link you choose, ensure that it is obvious to any user, not jusl you, the creator, Making
links easy to identify helps if you want to reuse & lesson al a later date. It's also easier for substitute teachers,
students or others whao use the lesson to find the link. To make your link obvious, preface it with an
insbructional statement such as Click here to view a virfual four of Tutankhamurn’s tormb. Create navigation
buttons that look like buttons and have text an them to say what they do. forinstance, back, on a button that
links te & previous page in the lesson, If you've made text into a linking object, change the font to blue and
underline it. This achion makes it appear like the mare familiar webpage text link.

Effective object links

Click the image to view a virtual
tour of Tutankhamun’s tomb

Image used as an olject lnk with an
Instrucional sfafement toJocede of for
fhe wser

The discovery of Tutankhamun's tomb by Howard 7= used as an abject ink and
formztted o lpok ke 5 famiiar

Carter in 1922 was considered one of the most  wessage fext ink

Effective newigaiion huftons ook il
huttons and incorporate insfructional
axt

Check your lessons after you've created them to make sure that all of the links go where you want them to
go. If you are linking to another page in your lesson, make sure there is a back button ta relurn lo where you
slarted so that the flow of your lesson is not disrupted. If you are using a leszon that someone else created

or that you created some time ago, it is a good idea to check the links to confirm that they still lead to active
websites.

Use interactive and multimedia content judiciously

Multimedia elements are a popular way to integrate content te your lesson activities and appeal to different
lzarning stvles. These tools are a good supplement 1o any lesson, but should be used with some restraint.
Filling every page with animations, videos and sound can distract students from the learning objectives and
direct their focus lo the technology instead of to the content of your lessan

Use and experiment with all the tools available lo you, but make sure you know why you are using a specific
tool — to meet a learning ohjective,

120



Matebook software {raining for SMART Deard ugers leval 1 leamer workbaok

Target student age and ability

Effective teachers design lessons that are targeted appropriately to the age and ability of the students they
are teaching. This is easier said than done because there is typically a wide range of abilities in the
classroom. Additionally, the teacher may not always correctly anticipate how much background knowledge
a group of students have about 8 topic. This section outlines some ideas about how to take advantage of
the added flexibility of teaching on an interactive whiteboard to better target the abilities and previous
knowledge of students.

Make a note of prior knowledge and lesson objectives

Add a section to the teacher's notes at the beginning of your lesson that outlines the background knowledge
studenis have prior to beginning the aclivity, and specific learning objectives your lesson will target,
Including this information in your lesson file helps focus your attention on these ideas while you are
developing your lesson content. It also provides important background information o substitute teachers or
any other teachers wilh whom you may wish {o share your lesson activity.

Take advantage of added flexibility

When you are planning and building a lesson, it may be necessary to make certain assumptions about the
ability level and prior knowledge of the students. Pre-lesscn assessments such as pre-tests and KWL charls
(Know, Want to know, Learned) are wonderful ways 1o minimize the assumptions you'll have to make in
futlure leszons. These lypes of pre-lesson assessments can easily be done on the interactive whiteboard
and saved for reference later in the unit.

A major advantage of interactive whileboard use is their flexibility. If a teacher is in the middle of a lesson
and he realizes that he's misjudged student ability or prior knowledge, he has the ability to draw on all the
rescurces of the World Wide Web or the content fram his interaclive whiteboard provider to spontaneously
provide background for his lesson. Pausing your planned lesson to pull up a search engine or a website that
you've previously identified and attached to your lessan is an excellent way lo explore and build
foundation for a topic before continuing with 2 lesson, Mot only does this lesson flexibility ensure that all
students have a solid base on which to build further content, but it demanstrates to students how they can
take action when they don't fully understand a topic or assignmenl

Give students access to information outside of class

Conducting lessons on an interactive whiteboard ofters the flexibility of easily printing lesson materials or
posting them to a class website. This approach makes content available to students who missed class o
who will banefit from extended aceess o material,

Consider literacy

If students in your class have low levels of literacy, consider using visuals such as images. videos or
diagrams to make your point. Leave text to play a supporting role. Incarporating visuals is an area where
using an interactive whitebeard to teach has major advantages. When evaluating the literacy of your class,
don't forget about special-needs students and students for whom the language of instruction is not their first

language, Using visuals s also a great way to teach language literacy because it relates the words you are
speaking and writing to a visual representation that students can identify.
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Differentiate instruction seamiessly

The interaclive whileboard allows for easier integration of differentiation strategies within a lesson. Several
different levels of activities can be prepared and organized in advance, allowing teachers to spontanecusly
select the one that seems most appropriate during the lesson. Teachers can also offer different levels of
questions to particular students based on their ability, without it being obvicus that some students are getting
easier questions. Pull tabs are another good way to stare informalion of varying difficulty and display it as
needed. Using hide-and-reveal strategies in lessons also allows you to change the level of difficulty by
keeping supplementary information hidden unless it is needed.

Full tgb intorrmatian stored Fuil taly fnfarmation reveaiod

F What are the hemophones for
these wards?

F What are the homaphones for
these wards?

bareds wak : | | b wieek/
chechd LA Ty
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Lducators can also differentiate by color-cading inleractive whiteboard questions by level of difficulty or
displaying different streams of assignments on the interactive whiteboard for students Lo work on
independently,

Differentiate by recording your process

Some interactive whiteboards have a — - =
recorder tool that allows teachers to
record the steps they take on the
interactive whiteboard and play them
back to students at a later time. For
example, an instructor can turn on the
recarder feature, walk a class through the
sleps required to solve amath problem by [
doing an example on the interactive '
whiteboard, stop the recorder feature and \
set il lo play it back repeatediy for the by
class to reference while they work. '

Use of the recorder feature allows strong

students to get on with their work without

the tedium of repeated whole-class .
instructinn, while supporting the middle i ISl ——— : e———— R
and low ability students who may need to

reterence the instruction many times as they work. If a microphone is attached to your computer whan the
process is recarded, sound will be included with the file. A narrated recording of & process is useful for
posting on a class website or sending to students who were away.
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Enable active student participation

One of the biggest benefits of teaching onan inleractive whiteboard is the ability for students and teachers
ta interact with objects and activities on the page. Interaction with the whiteboard, apart fram just
manipulating the screen, allows for more active learning to take place, This means that instead of treating
students as receptacles for knowledge and trying to filf thern up with information, students are given the
power o canstruct their own meaning out of the content you provide. Many cducators belisve that
information learned through active processes are more easily retained, and are retained over a longer
period, than information thal is passed on passively to the student, Enabling active student participation with
lessons also gives the teacher an opportunity to assess student learning

The follewing section offers suggestions about how to design interactive whiteboard lessens that encourage
student participation,

Create hide-and-reveal actlivities
One of the quickes! ways lo add interactivity to a lesson What i< the |ur‘gEST land mammal?
is to hide the answer to a question behind an object on
your interactive whiteboard page. Instead of giving
students a picce of information, write a queslion for Move the Box
students o answer and hide that answer under a box ar to reveal 1h;¢
an object that can be moved out of the way to reveal the EhlaE
answer, Alternatively, you could use the Screen Shade
toel to accomplish a hide-and-reveal aclivily.

answer

Create drag and drop activities

Urag and drop activities are an excellent way to determine if your class has understood the lesson, Drag
and drop activities work well wilh labeling exercises, sorting exercises, ordering, counting and matching
This 1s one area where interactive whiteboard technology really shines, |t is extremely easy to create a drag
and drop activity on an inferactive whiteboard, compared to creating a sorting exercise with paper. It is much
sasier for a whole class of students to see a demonstration when this type of activity i done on an
interactive whiteboard rather than with real objects, particularly small objects Drag and drop activities keep
your class active and engage more parts of the brain because of the physical movement invalved.

Labeling a diagram is an excedent drag a0 drop actisly,

It is & good idea to copy your drag and drop lesson activities onto another page at the end of your lesson to
create an answer key, [his page will help future users of the file find the correct answers.
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Drag and drop aclivilies can also be used for text-based lessons. For example, you might drag events to
specific dates on a timeline or define a series of words.

Word Definition

A naming word

A doing word

This word can medify a verb or an adjective

This word modifies a noun or a pronoun

Lise drag and dron aoifvities 1o ealiven lexl-Dased fessons.

If your interactive whiteboard software offers an infinite cloning feature, T e

Lhis can be very advantageous when creating drag and drop activities. i "% Filiddeis
The Infinite Cloner feature allows you to create a pool of choices that ( ! Ry

students can drag from as often as needed without diluting the pool of Ly T
available oplions. vazunls rmilochandna

Incorporate Flash activities

Flash is a software application that is used to create animated images
and interactive graphics. All interactive whiteboards will allow users to
view websites where students can access and manipulate Flash ohjects,
and some interaclive whiteboard providers supply educational Flash
content that can be used directly within a lesson. Interactive Flash
activities and similarly dynamic graphics help achieve learming objectives
and bring the lesson {o life. Finding a Flash object that enhances your
lesson, or creating your own if you have Flash software and the
necessary skills, is a way to incorparate more complex inferaclivily into
lessons that demand it

Get and record students’ opinion

Engage students’ opinion by taking votes with an interactive response
system, which 1s sold as an interactive whiteboard add-on by some
interactive whiteboard providers, or a simple tally on the interactive
whitebcard. Opinion polls stimulate discussion and allow students to
participate actively in a lesson. Saving vour software file with the veting resullz recorded allows you to bring
up these results later on In the unit to see whether opinions on the issue have changed with further studly.

Liza Infinite Cloner bo fabel praphics
that nead o use the same efemenl
freare ihan Dnee,

124



Matebnok software training for SMART Board usors level 1 learner workbook

Cater to multiple learning styles

The term multiple learning styles refers to the theory that individuals are naturally mere able to learn material
that is presented in a particular way. Educators will often refer to visual leamers, auditory learners and
kinesthetic, or body movement, leamers.

The best lessen design is one that considers and targets a number of different leaming preferences.
Interactive whiteboards have a unigue advantage over a screen and digital projector in thal lessons can be
manipulated physically such as in a sorting exercise. Appeal lo as many learning styles as you can within
a single page or activily, without sacrificing clarity, and vary the approach from page to page so that there's
something to address every leaming style within a single lesson

This section outines some of the ways that interactive whiteboard lessons can help you cater to multiple
learning styles.

Incorporate interactive and multimedia content
Video and animaled Flash-created content can 111 " S S e T
easily be incorporated into your interactive ; o : e e R
whiteboard lesson. Video content can be usedto | ' ’
give students an impression of a historical event
or to demansirale how something moves, suchas | ! | BIE [ | me |
microscopic cells, Flash-created content can be I - AL : [ Iieeesi R o FNEH| 8
used as an alternative to video for something that ' 1 T
cannot be videotaped, such as movement of g line i i3 ol { i _ TR
on a graph, or when you want students to interact | | / R S e s
directly with a learning chject and receive inslant ! | L
feedback. Many students learn better from seeing |l i S e
something in action, rather than just hearing or (R i, £ ' T

P . Ll . L B i
reading about it gl S '*m'-mﬂqo- A

e
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i

i
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Interactive Flash content can be especially
valuable for lhe substantial proportion of learners
who need to understand difficult concepts — mathemafical concepls, for example — in context rather than as
an abstraction. Teachers can use the Flash learning objects made available by their interactive whiteboard
provider or link to the many education websites that provide these resources.

Incorporate sound

Some collaborative leaming software for the interactive whiteboard makes it easy to engage auditory
learners by using sound within a lesson activity. |Lis also a good way to give students insight into a speaker's
persanalily — histening to a historical speech, for example, rather than reading it can be more engaging for
students, Ancther way to use sound is to give immediate feedback 1o students when they interact with
specific objects in the interactive whitehoard lesson. Try recording applause to use for correct answers or
the words fry again far incomect answers.

some interactive whiteboard providers make sound files available to users as part of their educational

resource offering. You can also record sounds or text using a digital recorder or download sound files from
the Internet,

Make it active

Inviting students up to the interactive whiteboard to move or sort objects engages kinesthetic leamers.
Seeing ohjects being moved around the interactive whiteboard engages visual and spatial learners.
Increased interaction between students and teachers engages verbal learners, All students learn best from
active rather than passive processing of information. In shor. keeping lessons active and interactive will
appeal to more siudents needs than lecture-style content delivery.
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Consider special needs

Inclusive education practices have made loday's classrooms very diverse. Most teachers need to consider
the special neads in their classroom such as those of English language leamers (FLL}, students with
learning or behavioral disabilities and even those with severe disabiliies. This section cutlines some ideas
to help you consider the special needs in your classroom when teaching on an interactive whitebaard,

Access key lesson vocabulary when you need it

An effective instructional strategy for English language leamers is (o include key vocabulary for the lesson.
An effective way to handle key vocabulary an an interactive whiteboard is to use a hide-and-reveal
technique or pull-taby. This approach allows the instructor to address key vocabulary at the beginning of 2ach
presentation page or activity and then store it away to beller aceess the main page content. This type of
interactivity also gives the teacher the flexibility to bring that information out enly if. or when, needad. The
text on these key vocabulary tabs 1s an independent object — that's why you can move it around. 1t is an
easy task to collect all of the key vocabulary in your lessen onto a single page to print. ELL students or
struggling readers can use this advance vocabulary list to familianize themselves with key words before the

full-class lesson,
Acid Rain
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Students with severe disabilities also benefit from interactive whiteboard use
Students with severe cognitive and physical disabilities can derive a great deal of benafit from interactive
whiteboard use. These students can learn action-and-response and physical coordination. Use interactive
whiteboard software to customize the aclivity to what the particular student enjoys. For some students,
linking & sound file that will play when a student interacts with an object is very effective. Other students may
prefer o be ewarded wilh images of faces or animals, animated objects, or changes in color, VWhen
designing your interactive whiteboard activity, keep in mind that some students may be sensitive to glare,
s0 consider using a pastel shade such as beige or light blue for your page background. Some students with
severe disabilities also suffer from visual impairment, so consider keeping objects and any text quite large.

Interactive whiteboards thal respond to touch pressure have an advantage over those that operate with an
electromagnetic pen when they are being used to teach studenis wilth severe disabilities, Those students
who find it difficult to grip a pen or stylus can use other implements to write or to navigate a touch-sensitive
board. These studenls might find it easier to grip a tennis ball, drumstick or manipulate the interactive
whiteboard with their hands,
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